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TO OUR CUSTOMER
To Our Customer

Thank you for purchasing our products. We are confident they will increase the 
productivity of your office.

A Total In-house Solution
Thomson Tax and Accounting (TTA) provides a total in-house solution designed to 
enhance profitability and boost the task-by-task efficiency of today’s accounting 
professionals.

Our tax applications provide a comprehensive system that handles virtually every type 
of return, reducing tax preparation and review time by as much as 50%. Only TTA’s tax 
compliance system offers a complete audit trail using hyperlinks to detail calculated 
amounts and provides print preview of data on actual tax forms--all on-screen. 

Contacting Thomson Tax & Accounting

For information about our products:

• Call 1-800-327-8829.
• Visit us on the World Wide Web at:

http://www.InSource.Thomson.com/.

• Visit the Product Assistance Web site for additional information about products 
and services, including specifications, training, release dates, and guides. You can 
access the Product Assistance Web site by clicking Support on the Web from the 
product’s Help menu. 

Before You Contact Systems Support
Before you call Product Support, please try any of the following that may be 
appropriate for the problem: 

• Check Help – Help not only explains how to use the Tax Application, but also 
contains answers about how TTA handles information and interprets tax law. 

• Check How Do I – How Do I help provides (by way of the Help menu) extra 
product information that you may find useful. It includes helpful hints, known 
problems, information about corrected and updated software features, plus issues 
and resolutions of frequently asked questions concerning tax processing. All listed 
problems appear with their current workarounds and proposed resolution dates.

• Check Release Notes – User Information under Release Notes alerts you (by way 
of the Help menu) to any limitations in the current release and corrected 
limitations from prior releases, as well as helpful hints.
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CONTACTING THOMSON TAX & ACCOUNTING
• Check Product Assistance – Product Assistance provides up-to-date information 
for each application, including Release Notes, Post Release Known Issues, and 
Tips and Techniques. You can obtain daily updates by registering for E-mail 
Notification as well. Go to https://InSource.Thomson.com/support for more 
information.

• Check with your LAN, System, or RS Administrators – They should have the 
training and experience to handle many situations that arise with your Tax 
Application software or equipment.

Support Hours and Numbers
For the latest information on our support telephone numbers and hours of operation, 
please see our Product Assistance Support Web site. 

On the Product Assistance support web site, you can locate the Support Center 
telephone numbers or support hours by selecting Support Numbers or Support 
Hours on the top menu. 

Product Assistance Support Web Site
The Product Assistance Support Web site features the following information:

• new and updated features
• technical bulletins (important, emergency-type information)
• software updates
• post release known issues
• release notes
• FAQs
• product release schedules
• service requests 
• telephone support information, including telephone numbers and hours of 

operation
• installation instructions
• online guides
• system requirements
• training opportunities
• TTA events
• e-mail notification.
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CONTACTING THOMSON TAX & ACCOUNTING
Accessing the Web Site
You can access Product Assistance from the Internet or through the Tax Application. 

Through the Internet
To access Product Assistance from the Internet, go to https://InSource.Thomson.com/
support.

Through the Tax Application
To access the Web site from an application, do the following:

1. From the Help menu, click Support on the Web. The Login screen appears.

2. In the User Name field, type ccare\ followed by your account number. Please note 
that this is not the same user name that you use for e-mail notification.

3. In the Password field, type your password. All passwords are case-sensitive, and 
must be typed exactly as assigned.

4. Click OK.

5. From the drop-down menu in the upper right frame, select your product.

6. Select the item you wish to view from the menu tree in the left frame.
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SETTING SYSTEM DEFAULTS
Setting System Defaults

Default Information
System default information transfers into the software from Manager as read-only. 
This information cannot be changed in Trial Balance Bridge. 

Entity Information Overview
The following default information is read-only in Trial Balance Bridge: 

• Locator number
• Return type
• Rounding default of dollars or cents
• Entity name
• Fiscal year begin date
• Fiscal year end date. 

Changes being made to everything (except the Locator number, which cannot be 
changed) should be made in the Organizer. To make your changes, in the General 
Information folder, click Company Information.

Note:
In order for the changes to be reflected in the Trial Balance Bridge, you must exit the 
locator and then re-open the locator again.

Setting Trial Balance Bridge Defaults
You can change certain default settings in Trial Balance Bridge. On the Options menu, 
click Return Defaults. The Return Defaults dialog box appears. 

How to Change Default Settings
The following describes the default field and explains how to change it. Once you have 
entered your change, click OK to activate.

If the trial balance is in 
balance and open

Type the equity account number where you want to 
close Income or Loss. The current year earnings are 
then closed to the specified account, displayed as a 
book adjustment on the Account Detail dialog box 
and included in the Adjusted Book Balance.

If the trial balance is in 
balance and closed

Type CLOSED in place of the account number.
TRIAL BALANCE BRIDGE ONLINE GUIDE 6



SETTING ROUNDING DEFAULTS
Note:
• If you do not specify an account number, Trial Balance Bridge automatically 

closes the books to the first retained earnings account for 1120, 1120-C, 1120S, 
1120-RIC, and 1120-REIT (TRC 22-310), or the ending partners’ capital 
account (TRC 22-500) for 1065.

• Trial Balance Bridge calculates the amount of Net Income per Books to close by 
adding the Adjusted Book Balance of all 30- and 40- TRC categories.

Setting Rounding Defaults
 Amounts within Trial Balance Bridge can be entered as dollars or cents. You may 
elect to round within Trial Balance Bridge to view workpapers and tax summary as 
rounded amounts.

• If the locator is a cents return, the rounding option is not available in Trial Balance 
Bridge, and non-rounded amounts are merged into the tax application.

• If the locator is a dollar return, Trial Balance Bridge rounds automatically. 
However, you have the option to toggle rounding off. On the Options menu, click 
Rounding. If rounding is turned on, all amounts are rounded.

Trial Balance Bridge generates an item that appears as an adjustment on detailed 
workpapers and on account detail in tax summary. This amount handles any 
discrepancies in the rounded amounts during the calculation.
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ROLLING OVER TRIAL BALANCE BRIDGE LOCATORS WITHIN MANAGER
Rolling Over Trial Balance Bridge Locators Within Manager

1. Select the prior year locator(s) from the Tax Register. 

2. On the Utilities menu, click Rollover. The Rollover dialog box appears.

3. If current-year data exists for the return you are rolling over, select one of the 
following options:

• Prompt - you are warned if current-year data already exists for the return 
selected.

• Bypass - the prior-year data is not rolled over.
• Rollover - the prior-year data is rolled over even if current-year data exists.

4. Select whether to be prompted for a password or to rollover the data without being 
prompted.

5. Select OK. The rollover process is complete.

Rollover Process
Rollover eliminates having to re-enter certain information and also reduces the risk of 
data entry error.

 If a return was bridged in the prior year using Trial Balance Bridge, you can roll over 
the data in Manager. 

The following methods for rollover are available:

• Rollover returns at TTA.
• Rollover only Windows locators in your office via the Manager Rollover Utility.

Rollover Data List
The following data is rolled over:

• Account numbers
• Tax Combination Code Descriptions
• Account descriptions
• Property Codes [PCs (1065, 1120S, and 1120-REIT)]
• Tax Return Codes (TRCs)
• M-3 Return Codes (MRCs)
• Journal Entries: book adjustments, tax reclassifications, Schedule M-1/M-3 

adjustments and Schedule M-2 adjustments
• Tax Combination Codes (TCCs)
• M-3 Tax Combination Codes (MCCs)
• M-3 Part II Company Details
• Ending current-year balance (if it exists).
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IMPORTING DATA
Note:
During the rollover process prior-year ending balances become current-year beginning 
balances. Current-year ending balances are left blank.

Importing Data

Types of Data That Can Be Imported

Trial Balance
• Account Number
• Account Description
• Prior Year Balance
• Current Year Balance
• Tax Return Code
• Tax Combination Code
• M-3 Tax Return Codes
• M-3 Tax Combination Codes
• Property Code
• M-3, Part II, Company Detail
• Workpaper Reference.

Journal Entry
• Journal Entry Type
• Journal Entry Number
• Journal Entry Description
• Account Number
• Adjustment Amount per account
• JE T/P (Temporary/Permanent)

Tax Combination Code Descriptions
• Tax Return Code
• Tax Combination Code
• Tax Combination Code Description.

• M-3 Tax Combination Code Descriptions
• M-3 Return Code
• M-3 Combination Code
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IMPORTING DATA
• MCC Description

• M-3 Company Detail
• M-3 Return Codes
• Company Name
• EIN (Related to Company Name)
• Balance (Book Balance: Income/(Loss)
• Temporary Difference (Income/(Loss)
• Permanent Difference (Income/(Loss)
• Entity Type
• Class of Stock
• End-of-year Profit % (12.5 for 12.5%
• End-of-year Loss
• Description
• Tax Shelter Name
• Tax Shelter Reg #
• Reportable Transaction Type
• Percentage of Stocks Directly or Indirectly Owned (12.5 for 12.5%)
• Reason for Missing EIN (A: "APPLD FOR"; F: "FOREIGNUS"; leave blank 

otherwise)

Import Data File formats and Data Imported
The following tables show the data source files formats and the data that can be 
imported from each Audit and General Ledger package.

Audit 
Pkg

Descrip-
tion

File 
Type

Data Imported

Acct
#

Desc PYB CYB TRC TCC PC JE MRC MCC

BFS KPMG Basic 
Financial 
Statements

*.bfs, 
*.dlm, 
*.csv

x x x x

Caseware Caseware 
International

*.ft, 
*.dlm, 
*.csv

x x x x x x x x x x

CBEAM Grant 
Thornton LLP

*.prn, 
*.txt

x x x x x x

CSA Trial Balance 
Solutions by 
Creative 
Solutions

*.gld, 
*.gle

x x x x x

EY Audit Ernst & Young 
LLP Audit 
Link

*.ey, 
*.dlm, 
*.csv

x x x x x x x

GoSystem 
Audit

Creative 
Solutions

*.dlm, 
*.csv, 
*.ft

x x x x x x x x
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IMPORTING DATA
^Also imports TCC Descriptions.

Predefined versus User-Defined Formats

Predefined Formats
In the predefined formats, Trial Balance Bridge looks to specific locations in the data 
source file for certain information. These locations are preset. For every import of data 
from that listed package, Trial Balance Bridge automatically locates the required fields.

User-Defined Formats
In the user-defined formats, you tell Trial Balance Bridge where specific information is 
located in the source file. Your data can be in a variety of formats; you simply specify 
where the pertinent data is. By importing from user-defined formats, you expand the 
flexibility of bridging. You can import data from packages or external software (for 
example, spreadsheet software) other than a predefined audit or general ledger 
package.

User-Defined Templates
Trial Balance Bridge contains the following types of user-defined templates:

• Trial Balance
• Journal Entry
• TCC Descriptions
• MCC Descriptions 
• M-3 Company Detail 

ProFx 
Engagement

ProSystem fx 
Engagement 
by CCH

*.ria, 
*.dlm, 
*.csv

x x x x x x x

ProFx 
TrialBal

ProSystem fx 
Trial Balance 
by CCH

*.prn, 
*.txt

x x x x x x

G/L Pkg Description File 
Type

Data Imported

Acct
#

Desc PYB CYB TRC TCC PC JE MR
C

CLS FMS\Client 
Ledger System

*.dat, *.dlm, 
*.csv

x x x x

CSA WSW by Creative 
Solution

*.gld, *.gle x x x x
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PREPARING FILES FOR IMPORT
Source File Formats
Trial Balance Bridge supports the following file formats: 

• Data Interchange Format (DIF)
• Character Delimited File (DLM, CSV)
• ASCII/PRN - Text File (TXT, PRN)
• Microsoft Excel (XLS).

Note:
When importing from Microsoft Excel, the files must contain column headings/
descriptions in the first row in order to import correctly.

Preparing Files for Import

Field Lengths
Trial Balance Bridge sets a character-length limit to the elements that can be imported. 
To avoid import errors, check the file to ensure that the following requirements are 
met. 

Extraneous Items
To avoid import errors, examine the files prior to import for extraneous items. Trial 
Balance Bridge recognizes and removes the following items for you.Debits and Credits

Element Requirement

Account number No more than 30 characters

Account description No more than 50 characters

Prior-year balance No more than 15 characters

Current-year balance No more than 15 characters

Workpaper reference No more than 5 characters

Tax Return Code System Defined Codes

Tax Combination Code No more than 3 characters

Property Code No more than 3 characters

M-3 Return Code System Defined Codes

M-3 Combination Code No more than 4 characters

Item Example

Spaces or blanks on TXT formatted columns in DLM 
and PRN files

_Cash_
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PREPARING FILES FOR IMPORT
Trial balance files and journal entry files should be balanced prior to import. Trial 
Balance Bridge reads debits and credits as shown below.

Import: If Package Is Not Listed
 Trial Balance Bridge supports specific general ledger and audit packages for bridging. 
You are not limited to importing only from these packages. In fact, Trial Balance 
Bridge is flexible in the file formats that it accepts. You can create a user-defined 
template for the file and import the data using the user-defined template. In preparation 
for template creation and for the import process, you should know certain facts about 
the file.

File Type
You should know the file format type of the source file. The extension of a file is a 
good indicator of the file format type, but it is not completely reliable. For example, 
you can rename a spreadsheet file that has an XLS extension to a file named with a DIF 
extension. According to the file name, it appears to be a DIF file, but it is not in DIF 
format. The spreadsheet file must be translated by the source software into the DIF 
format, not simply renamed.

User-defined templates can be designed to import the following file formats:

• DIF
• ASCII/PRN
• DLM
• Microsoft Excel.

Quotes on TXT formatted columns in DLM, PRN and 
DIF files

“Cash”

Quotes on columns containing account numbers “1000”

Leading zeros on columns containing amounts 000156.98

Dollar signs in columns containing amounts $

Format Read As

 100.00 Debit

 100.00+ Debit

+100.00 Debit

 -100.00 Credit

 100.00- Credit

 (100.00) Credit
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PREPARING FILES FOR IMPORT
Delimiter Used
For character-delimited files, you should know the delimiter used in the source file 
before creating a user-defined template. Common delimiters are tabs, commas, semi-
colons, colons, and asterisks.

Import from ASCII/PRN File
Trial Balance Bridge contains an Auto Parser to assist users in importing data from 
ASCII/PRN files. The Auto Parser displays the data in the import file and allows you to 
set column breaks to create the template for this type of source file.

The Auto Parser attempts to determine where each column begins and ends and, if 
selected, shows possible column breaks.

Import from Excel
When importing from Microsoft Excel, the files must contain column headings/
descriptions in the first row to import correctly.

Location of Import Elements
When you are creating a user-defined template, Trial Balance Bridge makes it easy for 
you to identify the data in the source file that you want to import. Nevertheless, you 
should know in advance the basic structure of the source file. For example, is the 
account number in the first column or third column? Is the account description in the 
second column or fourth column? Knowing the location of all elements you plan to 
import facilitates the import process.

How to Find File Information
For general ledger and audit packages that are not listed on the Import dialog box, 
check the documentation that came with the software for export capabilities and 
instructions. Most packages export data to a file format acceptable to Trial Balance 
Bridge (DIF, Microsoft Excel, ASCII/PRN, DLM).

Importing via Spreadsheet Packages
You may want to use a spreadsheet package as a middleman for preparing files for 
import. Most commonly used spreadsheet packages have the ability to export data in a 
file format acceptable to be imported into Trial Balance Bridge. Therefore, if the 
source file data can be imported from the original package into a spreadsheet package, 
the data can be imported from the spreadsheet file into Trial Balance Bridge.
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PREPARING FILES FOR IMPORT
Importing

 To import a package or template
1. On the File menu, click Import. The Import dialog box appears.

2. Select the desired data source: Audit Package, GL Package, or User-Defined.

3. Highlight the name of the package or template you want to import.

4. Select Import. The Trial Balance Import dialog box appears for Trial Balance. 
The Journal Entry Import dialog box appears for Journal Entries. The TCC 
Import dialog box appears for TCC Descriptions. The MCC Import dialog box 
appears for MCC descriptions. The M-3 Company Detail Import dialog box 
appears for M-3 Company Detail. 

5. Select the items you want to import. (Note: Mandatory items are preselected.) The 
system also may automatically select items that can be imported based on the 
indicated package. If you do not want an item imported, simply clear the check box 
next to the item.

6. Type Drive/Path/File Name in the Source File Information field (or select 
Browse and select the desired file from the Open dialog box.

7. Select Import. The Import Progress dialog box appears. When the import 
process is complete, a confirmation message displays. If errors exist, a message 
appears indicating that there are errors.

8. Select OK. The import process is complete.

9. Select Done. The Import dialog box appears.

10. Select Done on the Import dialog box to return to the Trial Balance Grid screen.

Importing Changes to the Source Files on the Auto Import List
1.  If you exit Trial Balance Bridge and make changes to your source files that appear 

in the Auto Import List, you are prompted, upon re-entering Trial Balance Bridge, 
with: “?:\path\sourcefile appears to have changed. Would you like to import 
again?” 

2. Answer Yes to automatically import the file to reflect the changed data, No to 
bypass import of the changed file and not ask the question the next time Trial 
Balance Bridge is accessed, or Cancel to bypass import of the changed file but not 
remove the opportunity for you to import the file the next time Trial Balance 
Bridge is accessed.

Adding Source Files to the Auto Import List
 Adding source files to the Auto Import list also allows easier access to source file 
names and locations if you choose to re-import through the normal import process.

1. On the File menu, click Import.

2. Highlight the desired template and select Import to display the Import dialog box.
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WORKFILES
3. Select your source file and your import items, then select Import.

4. After the import, a dialog box appears with the question “Do you want to add this 
file and format to the auto import list?” Select Yes.

Workfiles

Deleting a Trial Balance Bridge Workfile
 If there are numerous transfer errors resulting from erroneous column entries, the 
entire Trial Balance Bridge workfile should be deleted. 

Use this function when:

• a file is transferred into Trial Balance Bridge using incorrect parameters
• an incorrect data file is transferred into Trial Balance Bridge
• you wish to retry the transfer process.

Deleting the Workfile
 From the Trial Balance Grid screen, follow these steps to delete a workfile.

1. On the File menu, click Delete Contents. This option deletes Trial Balance Bridge 
data only and does not delete tax software files or any other application files.

2. Select one of the following:

• All Contents
• Journal Entries
• TCCs/Property Codes
• Prior Year Balances
• Current Year Balances (including amounts in journal entries)
• Workpaper Notes
• MCC (codes, descriptions, assignments)
• Company Detail

3. Select Delete.

Note:
If you delete property codes and TRCs exist that require property codes, Trial Balance 
Bridge automatically assigns a property code of 001 to all such TRCs. 
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Learning About User-Defined Templates

 Templates are used to import data into Trial Balance Bridge from sources other than 
the listed general ledger and audit packages. Templates are called user-defined because 
you define where the data is located in the source file.

A template is a guide for formatting. If you want to import trial balance data from a 
source other than the listed general ledger and audit packages, you can create your own 
template in Trial Balance Bridge.

Importing Journal Entries and TCC and MCC Descriptions
You can also create templates for importing journal entries, TCC descriptions, MCC 
descriptions, and M-3 Company Detail. You insure that the source data is in a specified 
format as dictated by the template. You tell Trial Balance Bridge which template to use. 
Trial Balance Bridge easily finds the data.

Creating Templates
You can create templates for:

• Trial balance data
• Journal entries
• TCC descriptions.
• MCC descriptions
• M-3, Part II, Company Details

To create a template:
1.  From the Trial Balance Grid screen, on the File menu, click Import. The Import 

dialog box appears.

2. Select User Defined.

3. Select New. The User Defined Import Template - Source File Definition dialog 
box appears.

4. Select the type of template you want to create: Trial Balance, Journal Entry, TCC 
Description, MCC Description, or M-3 Company Detail for CD/RS version.

5. Type the following information in the appropriate fields:

• Template name (up to 15 alphanumeric characters)
• Template description (up to 80 alphanumeric characters)
• Source file drive/path and file name (or select Browse, then select the file 

from the Open dialog box).
6. Select the appropriate Source File Format:

• DIF
• ASCII/PRN
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• DLM
• Excel

or
Select Automatic Detection to have Trial Balance Bridge scan the file and 
categorize it for you.

Note:
DLM files use a delimiting character, such as a comma, to indicate where a field of 
data stops. A delimiter is a character in your source file that is between the units of 
data. If you select DLM as your file format, the Delimiter drop-down box 
activates. Choose the delimiting character from the list that is used in your source 
file.

7. Select OK. The User Defined Import Template dialog box appears.

8. Highlight the item to import from the Import Item list.

9. Highlight the corresponding column in the source file (displayed in the Mark 
Import Item area of the screen). The column designator appears in the Column 
field.

10. Repeat Steps 8 and 9 for each item to import.

11. Type the beginning row number of the data you want to import in the Import 
Starting on Line field. Data on the row you select and all following rows is 
imported. Trial Balance Bridge defaults to Line 1.

12. If you do not want to password-protect your template, go to Step 15.
Note: If you want to password-protect your template, select Password. The 
Password dialog box appears. Adding a password prevents anyone else from 
modifying or deleting your template.

13. Fill in the desired password in the Enter New Password field, then again in the 
Re-Enter New Password field.

14. Select OK to add password protection.

15. Select Save. The Import dialog box appears. The creation process is complete. 
The new template that you created appears in the list on the dialog box.

Creating a User-Defined Template Using the Auto Parser
 Trial Balance Bridge contains an Auto Parser to assist users in importing data from 
ASCII/PRN files. The Auto Parser displays the data in the import file. You can set 
column breaks to create the template for this type of source file.

To create a user-defined template using the auto parser:
1. To access the Auto Parser, on the File menu, click Import.

2. Select User Defined as the Data Source.

3. Click New. The User Defined Import Template dialog box appears.

4. Enter a Template Name and Description in the provided fields.

5. Select ASCII/PRN or leave the format type at Automatic Detection.
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6. Enter the Drive Path and File Name or click Browse to select the source file from 
the Open dialog box.

7. Click OK to display the Pick Column Locations... (Auto Parser) dialog box.

The data contained in the selected source file displays. The Auto Parser attempts to 
determine where each column begins and ends and, if selected, shows possible column 
breaks.

Using Column Breaks
 If data, such as column headings, exist in the first or subsequent row, you can skip 
those lines by entering the number of lines to skip and clicking Re-check to have Auto 
Parser recheck for possible column breaks.

1. To add a column break, single-click where one column should end and the next 
should begin.

2. To move a column break, click and drag it to the desired location.

3. To delete a column break, double-click the break.

4. Once all columns have been determined, click OK. 

5. The User Defined Import Template dialog box appears. If you determine that a 
column break has been added in an incorrect location, simply click Cancel to 
return to the Auto Parser and correct it. 
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Merging Bridged Data

 Merging is the process of combining data from Trial Balance Bridge files with the tax 
return files. After the merge has occurred, you can add data in the tax software to 
complete the return. You can then perform final tax calculations and review and print 
the final return.

Merge is the final process you perform in Trial Balance Bridge.

Merge Defaults
 Merge defaults are locator-specific. You must set the defaults for each locator. 

You can set the following defaults:

• specify which forms to merge (rather than all forms)
• select creation and printing of detail schedules for detailable TRCs and MRCs
• suppress merge of accounts without balances
• suppress merge of prior year balances
• create cross-ties for consolidated returns (1120, 1120-C, 1120S, and 1065 only)

• Suppress merge of Part II Company Detail on Sch. M-3.

Accounts in 10- or 20- TRC Categories
 For accounts in the 10- or 20- TRC categories, Trial Balance Bridge checks both prior-
year balance and final tax balance (after M-1 adjustments).

Selecting Forms and Detail to be Merged

To select forms and detail to be merged:
1. Select Options | Merge Defaults. 

2. For each form tab, select whether to merge the form and any detailable items. The 
default setting is all forms and only IRS-required detail. The following form tabs 
are available:

• Income and Deductions, Page 1
• Rental
• Other Rental
• Royalty
• Schedule A
• Schedule C
• Schedule F
• Schedule K
• Schedule L
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• Schedule M-1
• Schedule M-2
• Schedule M-3

3. If you clear a detail item, Trial Balance Bridge adds the amounts (prior-year 
balances and balance after M-1 adjustments) and merges only the total.

4. If you clear a form, Trial Balance Bridge grays all detailable items and the 
information related to that form is not merged.

5. You can select from three overall options:

• Suppress Merge of Accounts without Balances: Select this check box if you 
have accounts with zero balances and do not want the detail for these accounts to 
be merged into the tax application.

• Suppress Merge of Prior Year Balances: Select this check box if you want 
your existing prior year balances to remain unchanged. The prior year balances 
from your import file will not be merged into the tax application.

• Create Cross-ties for Consolidated Returns (1120, 1120-C, 1120S, and 1065 
Only): Select this check box if you need cross-ties for consolidated returns. 
Cross-ties require certain TRCs and MRCs, if they exist, to have a TCC and an 
MCC respectively prior to merging. If the required TCCs and MCCs do not 
exist, the merge process displays an error dialog box listing the accounts that do 
not have a TCC or MCC, and the merge is not performed.

Suppressing merge of accounts without balances:
1. Select Options | Merge Defaults.

2. Select the Suppress merge of accounts without balances check box. 

3. When you select this check box, Trial Balance Bridge scans the Chart of Accounts. 
Any detailed item description with no PYB or CYB will not be merged. If this 
option is not checked, the detailed item description will be merged.

Suppressing merge of prior year balances:
1. Select Options | Merge Defaults.

2. Select the Suppress merge of prior year balances check box. When you select 
this check box, Trial Balance Bridge scans the account descriptions.

3. If the descriptions in the import file match exactly with the descriptions in the tax 
application, then the prior year balances within the tax application remain 
unchanged, and the current year balances are merged. If the current description in 
the tax application does not match the description in the import file, the new 
description is merged, and only the current year balance is merged. In either case, 
no prior year balances are merged.

Note:
This process is not case-sensitive.

To initiate a merge
1. Select Options | Merge Now. 
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2. Trial Balance Bridge merges the data in the Trial Balance Bridge file into the tax 
application file as follows:

• If selected forms have not been specified through Options | Merge Defaults, no 
tax forms are updated. You must specify which forms you want to merge.

• If selected forms have been specified through Options | Merge Defaults, only 
the selected forms are updated.

3. When you select Merge Now, all tax forms are updated as long as they have been 
selected on Options | Merge Defaults. 

4. To update specific forms, you must specify the forms you want to merge through 
Options | Merge Defaults. Only the forms that you select are updated with new 
data.

Merging Data into an Existing Locator
If data already exists in the locator, you can merge or re-merge bridge data from within 
Trial Balance Bridge and still maintain your data. However, data in all fields that re-
merged from Trial Balance Bridge will be deleted and new Bridge data will be merged 
to these fields.

If you do not wish to overwrite existing Organizer data, you can select one of the 
following options:

• On the Options menu, select Merge Defaults, and then select Suppress Merge 
of Prior Year Balances. Only the current year balances will be merged and Trial 
Balance will not delete any existing data.

Or
• On the Options menu, select Merge Defaults, select a form, and then clear the 

form to turn off merge options. Trial Balance will not merge to any field 
associated with the form that you cleared, and existing data remains in the 
associated fields within Organizer.

Tip: 
When possible, always finalize merging the Trial Balance Bridge data before adding 
information into Organizer.

Cross-Ties
 Cross-ties are used by 1120, 1120-C, 1120S, and 1065 returns only to facilitate 
consolidations in the Tax Application. Tax Combination Codes (TCCs) are required on 
all Tax Return Codes (TRCs) that are related to cross-ties if this option is selected. 
(MCCs) are required on all M-3 Return Codes (MRCs) that are related to cross-ties. 
See the listing of 1120 Tax Return Codes requiring TCCs and MCCs for Cross-ties. 

Generating Cross-Ties for Consolidated Returns
1. On the Options menu, click Merge Defaults.
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2. To create cross-ties for consolidated returns, select the Create Cross-Tie 
(Consolidated Return) check box.

TRCs without TCCs
If this option is selected and TRCs exist on the Trial Balance that do not contain TCCs, 
an error box displays with a listing of the accounts that require a TCC for cross-ties. 
The merge process does not continue until all TCCs have been entered. 

MRCs without MCCs
If this option is selected and MRCs exist on the Trial Balance that do not contain 
MCCs, an error box displays with a listing of the accounts that require an MCC for 
cross-ties. The merge process does not continue until the MCCs have been entered.

Note:
If this is a parent locator used for consolidations, it is not recommended that you 
suppress merge of accounts with zero balances.
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Exporting Trial Balance Data

 The export function allows you to use information from a locator in Trial Balance 
Bridge in some other application. For example, you can export journal entries to a file 
and import the file to a spreadsheet file. The spreadsheet file may be useful in 
recording monthly or quarterly journal entries.

Files can be exported in the following formats:

• DIF
• ASCII
• Excel
• Access

You can export:

• Trial balance data 
• Journal entries 
• TCC descriptions 
• MCC descriptions
• Company detail
• Workpapers.

Trial Balance Export
 The trial balance export file contains:

• Account Number 
• Account Description
• TRC, TCC, and Property Code
• MRC and MCC Codes
• Prior-Year Balance
• Preliminary Current-Year Balance
• Adjusted Book Balance
• Balance After Tax Reclassification
• Final Tax Balance after M-1/M-3 Adjustments
• Workpaper Reference Codes.

The trial balance export file is indexed by account number.
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Journal Entries Export
 The journal entries export file contains:

• Journal Entry Type indicator (BA,TR,M1/M3, M2) 
• Journal Entry Number
• Journal Entry Description
• Account Numbers
• Account Descriptions
• Adjustment Amounts
• Journal Entry T/P (Temporary/Permanent)

The journal entries export files are dual-indexed by journal type and number.

TCC Export
 The TCC export file contains: 

• Tax Return Code
• Tax Combination Code
• Tax Combination Code Description.

The TCC export file is indexed by TRC.

MCC Export
The MCC export file contains: 

• M-3 Return Code
• M-3 Combination Code
• M-3 Combination Code Description

The MCC export file is indexed by MRC.

Exporting Company Details
The Company Details export file contains:

• M-3 Return Code
• Entity Name
• Entity EIN
• Adjusted Book Balance
• Temporary Difference
• Permanent Difference
• Entity Type
• Stock Class
• End of Year Profit Sharing Percentage
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• End of Year Loss Sharing Percentage
• Description of Reportable Transaction
• Tax Shelter Name
• Tax Shelter Registration Number
• Type of Reportable Transaction
• Percentage of stocks directly or indirectly owned (12.5 for 12.5%)
• Reason for missing EIN (A: APPLD FOR, F: FOREIGNUS, leave blank 

otherwise)
The Company Details export file is indexed by MRC.

Exporting Data
1. On the File menu, click Export. The Export dialog box appears. 

2. Select one of the following export items: Trial Balance, Journal Entry, TCC 
Descriptions, MCC Descriptions, Company Detail, or Workpapers.

3. Select the file format for the exported file: DIF, ASCII, Excel, or Access.

4. Select the output file name including the drive and path or accept the default.

5. Click Export to start the process.

6. If errors occur during the export process, click Errors to review.

Workpaper Export
This feature allows you to export Trial Balance information to an Excel file in 
workpaper format. The types of workpapers available for export are:

• Taxable Income Detail
• Balance Sheet Detail
• Schedule M-1 Detail
• Adjusting Journal Entries.
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Making Journal Entries in Trial Balance Bridge

 Trial Balance Bridge allows you to enter a number of different types of journal entries. 
If a trial balance has been imported into Trial Balance Bridge prior to making adjusting 
entries, all book journal entries can be made while in Trial Balance Bridge. If amounts 
need to be adjusted to reflect the proper tax balance, all book/tax journal entries can be 
made while in Trial Balance Bridge.

You can make four different kinds of journal entries in Trial Balance Bridge:

• Book Adjustments: Book adjustments are entries that are posted to finalize 
account balances prior to any tax consideration. You can only post book 
adjustments to general ledger account numbers that are part of your chart of 
accounts in Trial Balance Bridge.

• Tax Reclassifications: Tax reclassifications allow you to reclassify balances 
between accounts for tax return presentation. Reclassifications cannot be made 
from the balance sheet to the income statement, but only between items on the 
balance sheet or between items on the income statement. If you are preparing an 
M-3, you will need to set up new general ledger accounts required for M-3 
presentation purposes and then map them  to the M-3 with MRC codes. You may 
then want to reclassify some of the book balances (or parts of the book balances) 
in the income and expense accounts to these new general ledger accounts required 
for the M-3.

• Schedule M-1/M-3 Adjustments: Use M-1/M-3 journal entries to reconcile book 
and taxable income.    If you are preparing an M-3, you must indicate whether the 
difference is temporary or permanent. (The default is temporary). These entries 
will appear on Schedule M-3, Parts II or III in columns (b) or (c). For M-1 
presentation, the entry must affect income, expense, or the balance sheet on one 
side, and Schedule M-1 on the other.   

Note:
The side of the entry that affects income or expense will also affect the M-3, if you 
made the entry using account numbers rather than TRC codes. If TRC codes were 
used, an entry will not be made to the M-3 because TRC codes are not mapped to 
MRC codes. Only account numbers are mapped to MRC codes. To create an MRC 
code for an M-1/M-3 journal entry when the entry was made using TRC codes, you 
must go back to the grid after the entry is made and manually enter MRC codes for 
the income or expense lines in the entry.   

• For Schedule M-1 enter:
• Debits for unrecorded taxable income and for nondeductible expenses
• Credits for recorded nontaxable income and for unrecorded deductible expense.

• Schedule M-2 Adjustments: Schedule M-2 adjustments record equity account 
transactions (for tax return purposes only) exclusive of net income or loss. Since 
Schedule M-2 is only a tax return analysis of a particular entity’s equity account, 
this type of journal entry is typically “one-sided.” Therefore, to balance each 
Schedule M-2 entry, Trial Balance Bridge creates an account styled “M2 
BALANCING ACCOUNT.” This account appears on the Trial Balance Grid 
without a Tax Return Code (TRC), is not included in any calculation and does not 
affect any account balance.
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Notes:
• Do NOT add a TRC to M2 BALANCING ACCOUNT on the Trial Balance 

Grid.
• Only the 62- TRC category listed under the TRCs… button (on the Journal 

Entry Detail dialog box) are available for Schedule M-2 entries.

Journal Entry Basics
Use the Journal Entry Detail dialog box to enter detail for a journal entry.

Entering Detail for a Journal Entry
1. The system automatically assigns the journal entry number.

2. Enter a brief description of the entry.

3. Enter the journal entry detail in the Journal Entry Grid.

4. For unbalanced entries, the Differences box shows the differences between total 
debits and total credits.

5. The Journal Memo text area allows you to enter any explanatory information 
about the journal entry. For example, you may want to add a special note for 
reviewers. Since journal entries are proformaed, you can leave a memo to next 
year's preparers.

6. Use the Prior and Next buttons to move from one entry to another. 

7. Select Done to exit the screen and save changes. 

8. Use the Accounts button if you are unsure of which account number you want to 
use. Click this button to display the list of accounts in your Trial Balance Bridge. 
Double-click the account or highlight and select Use Acct to enter this account in 
your journal entry.

9. Use the TRCs button for creating temporary accounts using the TAXnn-nnn 
feature. Click this button to display the list of TRCs and their descriptions. Double-
click the TRC or highlight and select Use TRC to enter a temporary account in 
your journal entry using the TAXnn-nnn format. 

10. Select the List TAXnn-nnn Accounts? check box to include existing TAXnn-nnn 
accounts in the list of TRCs that appear. 

11. Use the TCC Lookup button to view a list of TRCs and corresponding TCCs.

Adding a Journal Entry Line
1. On the grid on the Journal Entry Detail dialog box, go to the first available cell 

under Account and add your information for that line. 

2. To insert a line, highlight the line below where you want your new line to appear 
and click Insert.
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Entering an Account Description
1. If you enter a valid account on the Journal Entry Detail dialog box, the 

description automatically appears. 

2. If you enter an invalid account, an invalid account message appears in the 
description column and this row of the entry is not saved when you exit the 
Journal Entry Detail dialog box.

Entering Debits and Credits
1. When you enter debits and credits on the Journal Entry Detail dialog box, the 

software recognizes a number in the debit column as a positive number, and a 
number in the Credit column as a negative number. 

2. Whenever you type a number in the Credit column, the number changes to red and 
is considered a credit or a negative number. The number you type in the debit 
column remains black and is considered a debit or a positive number. 

Deleting a Journal Entry Line
1. On the grid on the Journal Entry Detail dialog box, highlight the line you want to 

delete. 

2. Click Delete.

Importing Journal Entries
Use the Journal Entry Import dialog box to import a source file. 

The Import From: field displays the journal entry format you selected from the Import 
dialog box.

1. To import a source file, either type the drive/path and file name in the Drive/path 
and file name: field, or click Browse and choose the file you want to import from 
the Open dialog box.

2. The Import Items area on the screen allows you to select the items you want to 
import. The Account Number, Journal Entry Description, and Journal Entry Type 
are mandatory items, and thus are already selected. Trial Balance Bridge may 
select items automatically that could be imported based on the indicated package. 
If you do not want an item imported, simply deselect by clicking the check box 
next to the item.

3. To perform an import, click the Import button.

4. If import errors are present, the Errors button activates. To review the errors, click 
the Errors button.

5. When you are finished importing, click Done.
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Using Automatic Journal Entries
1. On the Options menu, click Automatic Journal Entries.

2. Select the appropriate check box(es) to use automatic journal entries for:

• meals and entertainment (1120, 1120-C, 1120S, 1120RIC, 1120REIT, and 1065)
• federal income tax provision (1120, 1120S, 1120-C, 1120RIC, and 1120REIT)
• cost of goods sold (1120, 1120-C, 1120S, and 1065)
• guaranteed payments (1065 only).

3. For COGS, if selected, enter the TRC to which to assign the difference.

4. Click OK to save and close the dialog box.
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Understanding the TAXnn-nnn Feature

 The TAXnn-nnn feature allows you to create an account for the tax return that is not in 
the general ledger. TAXnn-nnn, where nn-nnn is a TRC, is the format for these special 
account numbers.

TAXnn-nnn accounts are temporary accounts used when a general ledger account is 
not already set up. An example of this is Officers’ Compensation. Trial Balance Bridge 
allows you to create these special accounts within the Journal Entry dialog box, and 
you can adjust or reclassify amounts from the regular general ledger accounts to these 
accounts. Once created, they appear on the Trial Balance Grid with no balances. This 
is simply a way for you to track all accounts associated with the return. It also allows 
these accounts to be exported with the amounts in their associated totals column.

Journal Entries
If you use a TAXnn-nnn account in a journal entry, Trial Balance Bridge uses the 
standard caption for the TRC as the TAXnn-nnn account description. If you specify a 
TCC and description with the TRC, you can use the TCC description by entering your 
account as TAXnn-nnn.nnn.

TAXnn-nnn and M-1 or M-3 Schedule
You can use the TAXnn-nnn feature with M-1/M-3 adjustments. Once again, you will 
have to go back to the grid to enter the MRC code. All M-1 TRCs begin with 6. There 
is no M-1 TRC for net income per books. This figure is computed from your entries 
and carries to Schedule M-1.

Generating a Detail Statement
 To generate a supporting schedule (detail statement) for Schedule M-1, enter the 
TAXnn-nnn account number with a TCC. For example, without a TCC you get the 
following:

For the description in the journal entry to carry to the tax return, use TCCs as part of 
the account number.

Enter: TAX60-240 Professional Services $500.00

Tax return detail: Other Book Expenses Not Deducted $500.00

Enter: TAX60-240.012 Professional Services $500.00

Tax return detail:   Professional Services $500.00
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Automatic Journal Entries
 Automatic journal entry accounts are displayed in the Trial Balance Grid with no 
balances. To activate automatic journal entries, on the Options menu, click Automatic 
Journal Entries . 

In the Automatic Journal Entries dialog box, you can select any of the following 
journal entries to be generated upon compute:

• Cost of Goods Sold (1065, 1120, 1120S)
• Guaranteed Payments (1065)
• Federal Income Tax Provision (1120, 1120S, 1120-REIT, 1120-RIC)
• Meals & Entertainment (1065, 1120, 1120S, 1120-REIT, 1120-RIC)

Cost of Goods Sold
 A book adjustment is performed if Cost of Goods Sold is selected.

Amounts Available for PYB and Preliminary CYB
for Beginning Inventory

Amounts available for Prior Year Balance and Preliminary Current Year Balance for 
Beginning Inventory (TRC 10-300) and Ending Inventory (TRC 10-300) are included 
with Beginning Inventory (TRC 40-110) and Ending Inventory (TRC 40-190). The 
difference between Beginning Inventory and Ending Inventory is reflected in the 
journal entry as AUTO40-120.

The account, AUTO40-120, is also included on the Trial Balance Grid with a default 
TRC of 40-120. You have the option of changing the TRC to an alternate tax line by 
selecting Options | Automatic Journal Entries.

Acct Number Description Debit Credit

AUTO40-110 Beginning Inventory X

AUTO40-120 Inventory Balancing Entry X

AUTO40-190 Ending Inventory X
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Adjustment for Schedule F: Farm
Currently an automatic journal entry for the Schedule F Cost of Goods Sold is 
unavailable. This tax adjustment can be manually entered with a journal entry as shown 
below.

Guaranteed Payments
 An M-1 adjustment is performed as a reclassification to income if Guaranteed 
Payments is selected. The amount for TRC41-230, TRC48-492, and TRC48-589 is 
summed and reflected in the following adjustment.

Federal Income Tax Provision
 An M-1 adjustment is performed if Federal Income Tax Provision is selected.

Note:
If you are preparing an M-3, it is not recommended that you use the automatic entry for 
the Federal Income Tax Provision. This is because the M-3 requires that you break out 
the provision between current and deferred and the AUTO41-400 includes both 
Current and Deferred FIT accounts. However, if the automatic entry is used, the MRC 
E550 will be automatically assigned to the account AUTO41-400.

Acct Number Description Debit Credit

TAX48-170 Beginning Inventory X PYB of TRC 
10-301

TAX48-173 COGS Farm Inventory 
Balancing Entry

X adjustment for 
purchases

TAX48-176 Ending Inventory X CYB of TRC 
10-301

Acct Number Description Debit Credit

AUTO60-120 Guaranteed Payments X

AUTO34-200 Guaranteed Payments X

Acct Number Description Debit Credit

AUTO60-110 Federal Income Tax X

AUTO41-400 Federal Income Tax X
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Meals and Entertainment  
 An M-1 adjustment is performed if Meals & Entertainment is selected. This 
adjustment limits the amount of Meals & Entertainment for tax return purposes within 
the bridge. Trial Balance Bridge, however, merges 100% of Meals & Entertainment 
into the tax applications and the tax applications then perform the limitation. 
Therefore, this M-1 adjustment also has the Exclude from merge option selected. 

1065

1120

The MRC E650 will be automatically assigned to the account AUTO439.

1120-C

The MRC E650 will be automatically assigned to the account AUTO439.

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Travel & Entertainment (100%) X

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X
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1120F

1120S

1120-REIT

1120-RIC

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X

Acct Number Description Debit Credit

AUTO60-216 Travel & Entertainment X

AUTO41-810 Meals & Entertainment (100%) X
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TERMS AND DEFINITIONS
Terms and Definitions

Refer to the following table for a description of each Trial Balance Grid component.

Term Definition

TRC A Tax Return Code (TRC) is a TTA-defined, code in the form of xx-xxx 
used to route general ledger account balances to specific lines on the tax 
return. For example, if the general ledger has an account for cash, assign it 
a TRC of 10-110 and the balance will be presented on the first line of 
Schedule L. Every account must have a valid TRC.

TCC A Tax Combination Code (TCC) is a user-defined, three-digit, numeric 
code that can be used in conjunction with TRCs to customize the 
presentation of printed detail schedules. TCCs are optional.

TCC 
Description

The TCC Description can contain as many as 50 alphanumeric characters.

MRC An M-3 Return Code (MRC) is an TTA-defined code used to route general 
ledger income and expense account balances to specific lines on Schedule 
M-3. All income and expense accounts in the general ledger must have 
valid MRC codes.

MCC An M-3 Combination Code (MCC) is a user-defined alphanumeric code 
up to four characters long that can be used in conjunction with MRCs to 
customize the presentation of printed detail schedules. MCCs are optional 
for lines where the detail is not required by law. If detail is required and 
no MCC is assigned the detail will not merge into Organizer.

MCC 
Description

The MCC Description can contain as many as 50 alphanumeric 
characters.

Property Code Property codes are mandatory in the 1065, 1120S, and 1120-REIT return 
types to differentiate between various rental activities. Property codes are 
user-defined, four-digit numeric codes. If property codes are not entered, 
Trial Balance Bridge defaults to a property code of 001.

Account 
Number

The general ledger account number can be alphanumeric with a maximum 
of 30 characters. Each account number must be unique.

Account 
Description

The account description can be up to 50 alphanumeric characters.

Prior-Year 
Balance

Prior-year adjusted book balances must be closed. The beginning balance 
sheet must be in balance. The income statement items are shown for 
comparative purposes only.

Current-Year 
Balance

Current-year trial balances can be entered closed or open. To indicate a 
closed trial balance, on the Options menu, select Return Defaults, then 
type CLOSED.

Workpaper 
Reference 
Code

You can record a code that corresponds to your workpaper labeling 
system. The code can be five characters long.
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Changing the Trial Balance Grid
 Change the Trial Balance Grid as you change a spreadsheet. You can resize columns 
and rows, insert and delete rows, move columns, sort the Grid, and go to specific 
accounts on the Grid.

Sizing Columns and Rows
1. Place the mouse pointer on the column or row label cell until the pointer becomes a 

crosshair (you must be in the cell label area of the Grid to change size). 

2. Hold down the left mouse button and drag the row or column to the size you want. 
When you change a row size, all rows in the Grid change. When you change the 
width of a column, the number of characters that field can hold is not affected (the 
account number can only be up to 15 characters regardless of the column width).

Moving Columns
1. Highlight the column you want to move by clicking on the label cell of the column.

2. Press Shift while holding down the left mouse button. The mouse pointer appears 
with a small rectangular outline.

3. Drag the column to where you want it and release the mouse button. The column 
appears in the new location on the Grid. You can move multiple columns that are 
side-by-side by holding down the Shift key while you click the side-by-side 
columns you wish to move, then by dragging them to the new location on the 
Grid. 

Inserting New Rows
1. Decide where you want the new row on the Grid. New rows are added above an 

existing row. 

2. Highlight the row that will come after the new row by clicking on the row label.

3. On the Edit menu, click Insert or press Insert. The new row appears above the 
highlighted row. 

Deleting Rows
1. Highlight the row you want to delete by clicking the mouse pointer on the row 

label for that row. To select multiple rows, hold down the Shift key and click the 
rows you want to select. 

Assign Coding 
Button

You can highlight a cell or range of cells in the Grid and display a TRC, 
TCC, MRC, MCC and/or a Property Code. When you select Assign 
Coding, Trial Balance Bridge assigns the selected code to the appropriate 
columns.
TRIAL BALANCE BRIDGE ONLINE GUIDE 44



CHANGING THE TRIAL BALANCE GRID
2. On the Edit menu, click Delete or press Delete.

3. A delete confirmation message appears. Click OK or press Enter. All the selected 
rows are deleted. 

Going to a Specific Account on the Grid
Use the GoTo dialog box to go to a specific account on the Trial Balance Grid.

1. On the Edit menu, click GoTo Account. The GoTo Account dialog box appears. 

2. Type the account number you want in the Number field.

3. Click OK. The Grid scrolls to the designated account, highlights it, and displays it 
at the top of the Grid view. 

Finding an Account by its Description
Use the Find Account Description dialog box to find an account on the Trial Balance 
Grid by its description.

1. On the Edit menu, click Find Account Description. The Find Account 
Description dialog box appears. 

2. Type any consecutive characters of an account description. (Find is not case-
sensitive.)

3. Click Find. The Grid scrolls to the account containing the specified characters.

4. If you want to continue searching for the specified characters, select Find Next. 

Sorting the Trial Balance Grid
1.  On the Edit menu, click Sort Trial Balance. The Sort dialog box appears.

2. Select the sort option you want.

3. Select OK. A progress dialog box displays. When sorting is complete, the resorted 
Trial Balance Grid appears.
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TAX RETURN CODES (TRCS) 
Tax Return Codes (TRCs) 

 A Tax Return Code (TRC) is a TTA-defined three-digit code used to route general 
ledger account balances and detail, if applicable, to specific lines on the tax return. You 
can assign or change a TRC in Trial Balance Bridge. 

Before you assign or change a TRC, you may want to sort the Trial Balance Grid by 
using the TRC option to place the accounts in TRC order on the Trial Balance Grid. 
Blank TRCs appear together at the top of the Grid.

Assigning or Changing a Tax Return Code (TRC)
1.  Go to the Trial Balance Grid screen.

2. Select the appropriate TRC in the drop-down list.

3. Select the appropriate cell(s) or row(s) of the account(s) to which you want to 
assign or change the TRC. To select multiple rows, hold down the left mouse 
button while you drag over the rows you want to select.

4. Select Assign Coding. The new TRC appears on the Trial Balance Grid for the 
account you selected. (You can also type the TRC on the Grid by placing the cursor 
in the TRC cell and typing in the code then pressing Enter.) 

M-3 Return Codes (MRCs) 
An M-3 Return Code (MRC) is aTTA-defined code used to route general ledger 
income and expense account balances to specific lines on Schedule M-3. M-3 Income 
(Loss) items begin with an “I” and Expense/Deduction items begin with an “E”. You 
can assign or change an MRC in Trial Balance Bridge.

Assigning or Changing an M-3 Return Code (MRC)
1. Go to the Trial Balance Grid screen.

2. Select the appropriate row of the account to which you want to assign or change 
the MRC

3. Select the appropriate TRC from the drop-down list. 

4. Select the appropriate MRC from the MRC drop-down list. 

5. Select Assign Coding. The new MRC appears on the Trial Balance Grid for the 
account you selected. You can assign a TRC code and an MRC code to the general 
ledger account at the same time if you have highlighted the entire row prior to 
selecting Assign Coding. (You can also type the MRC on the Grid by placing the 
cursor in the MRC cell and typing in the code and then pressing Enter.) 
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Tax Combination Codes (TCCs) 
 A Tax Combination Code (TCC) is an optional three-digit code that can be used in 
conjunction with Tax Return Codes to customize the presentation of printed detail 
schedules. TCCs are particularly important in generating cross-tie schedules for 
consolidated returns. TCCs allow you to group accounts, change white paper detail and 
provide supporting statement headings.

When accounts are combined, the default description for the combined balance is that 
of the first account included in the combination. You can change the description 
through Edit | TCC | PC | MCC.

Creating a Tax Combination Code
1.  Go to the Trial Balance Grid screen.

2. Select the appropriate TRC in the drop-down list.

3. Click the drop-down list for TCC and select Add New. The New Item dialog box 
appears. 

4. Type the TCC code and description in the New Code and Description fields. You 
can also type the TCC in the appropriate cell. You can use as many as 50 
alphanumeric characters in the description. The default description is the 
description of the first account where you assigned the code.

5. Click OK. The new TCC appears in the TCC drop-down list.

Assigning a Tax Combination Code
1.  Go to the Trial Balance Grid.

2. Since TCCs relate to TRCs, scroll through the TRC drop-down list and locate the 
TRC of the account to which you want to assign a TCC and select the appropriate 
TRC.

3. Select the TCC drop-down box. If a TCC has been assigned to a particular TRC 
and account, it appears with its description in the TCC drop-down list.

4. Click the TCC.

5. Select the appropriate cell(s) or row(s) of the account(s) to which you want to 
assign TCCs. To assign TCCs to multiple rows, hold down the left mouse button 
while you drag over the rows you want to select.

6. Select Assign Coding. The TCC displays in the TCC column (if you know which 
TCC to assign, you can type the TCC in the appropriate cell on the Trial Balance 
Grid).
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PROPERTY CODES (PCS) 
Changing a Tax Combination Code Description
1.  Go to the Trial Balance Grid screen.

2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog 
box appears.

3. Select Tax Combination Code Description to display TCCs and their 
corresponding descriptions.

4. Click the TCC description field.

5. Type the description change.

6. Press Done when all necessary descriptions have been changed.

Deleting a Tax Combination Code
1.  On the Edit menu, click TCC/PC/MCC Descriptions from the Trial Balance 

Grid screen. 

2. Highlight the row(s) containing the TCC(s) you want to delete.

3. Press Delete.

4. This function deletes the TCC and TCC description and removes this information 
from all accounts on the Trial Balance Grid associated with that TRC and TCC.

Property Codes (PCs) 
Property Codes (PC) are used in Trial Balance Bridge to differentiate between various 
rental, royalty, and farm activities. Each group of accounts pertaining to a particular 
activity should have its own unique Property Code. Property Codes are used in 1065, 
1120S, and 1120-REIT.

Property Codes must be numeric with a maximum length of three digits. If the tax 
return file is rolled over and contains data such as depreciation detail for a specific 
property or activity, be sure that the Property Codes you assign in Trial Balance Bridge 
match those already existing in the rolled over locator.

Note:
Property Codes must match the set numbers of related activities found in the tax 
application to properly align data.

Assigning a Property Code
1. Go to the Trial Balance Grid.

2. Determine the accounts and the TRC of the accounts to which you want to assign 
Property Codes.

3. Select the appropriate TRC in the drop-down list.

4. Select the drop-down list for PC and select the Property Code to assign.
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M-3 TAX COMBINATION CODES (MCCS)
5. Select the appropriate cell(s) or row(s) of the accounts to which you want to assign 
Property Codes.

6. Select Assign Coding or type the code in the appropriate cell.

Changing a Property Code Description
1.  Go to the Trial Balance Grid screen.

2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog 
box appears.

3. Select Property Code Description to display Property Codes and their 
corresponding descriptions.

4. Click the PC description field.

5. Type the description change.

6. Click Done when all necessary descriptions have been changed.

Creating a Property Code
1. Go to the Trial Balance Grid screen.

2. Select the appropriate TRC in the drop-down list.

3. Click the PC drop-down list, and then select Add New. The New Item dialog box 
appears. Note: PCs can only be added to TRCs that require PCs.

4. Enter the PC code and description in the New Code and Description fields. You 
can also type the PC in the appropriate cell. The default description is the 
description of the first account where you assigned the code.

5. Click OK. The new PC appears in the PC drop-down list.

M-3 Tax Combination Codes (MCCs)
An M-3 Combination Code (MCC) is an optional code up to four characters, that you 
can use in conjunction with M-3 Return Codes to customize the presentation of printed 
detail schedules. MCCs are particularly important in generating cross-tie schedules for 
consolidated returns. MCCs allow you to group accounts, change white paper detail 
and provide supporting statement headings.

Creating an M-3 Combination Code
1. Go to the Trial Balance Grid screen.

2. Select the appropriate MRC code from the drop-down list. 

3. Click the drop-down list for MCC and select<Add New>. The New Item dialog 
box appears. 
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M-3 TAX COMBINATION CODES (MCCS)
4. Type the MCC code and description in the New Code and Description fields. You 
can also type the MCC in the appropriate cell if an MRC code has previously been 
assigned to the account number. The default description is the description of the 
first account where you assigned the code. The description can contain as many as 
50 alphanumeric characters.

5. Click OK. The new MCC appears in the MCC drop-down list. 

Assigning an M-3 Combination Code
1. Go to the Trial Balance Grid.

2. Highlight the line for which you want to assign an MCC. Select the appropriate 
TRC code for that line. 

3. Select the appropriate MRC for that line, 

Or, highlight the MCC field (or fields of contiguous accounts that already have 
MRCs assigned.)

4. Select the MCC drop-down box. Existing MCCs and their descriptions are listed in 
the drop-down box.

5. Select an MCC.

6. Select Assign Coding. The MCC displays in the MCC column. (If you know 
which MCC to assign, you can type the MCC in the appropriate cell on the Trial 
Balance Grid.) 

Changing an M-3 Combination Code Description
1. Go to the Trial Balance Grid screen.

2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog 
box appears.

3. Select MCC Descriptions radial button to display MCCs and their corresponding 
descriptions. 

4. Click the MCC description field.

5. Type the description change.

6. Press Done when all necessary descriptions have been changed.

Deleting an M-3 Combination Code 
1. Go to the Trial Balance Grid screen.

2. On the Edit menu, click TCC/PC/MCC/Descriptions. The Edit TCC/PC/MCC 
Descriptions dialog box appears.

3. Select MCC Descriptions radial button to display MCCs and their corresponding 
descriptions. 

4. Highlight the row containing the MCC you want to delete.
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WORKPAPER REFERENCE CODES
5. Press Delete.

6. This function deletes the MCC and MCC description and removes this information 
from the account on the Trial Balance Grid associated with that MRC and MCC.

Workpaper Reference Codes

 You can import Workpaper Reference Codes as part of your Trial Balance import or 
add them directly to the Trial Balance grid. You can also add a note related to your 
Workpaper Reference Codes. On the Ledger menu, click Workpaper Notes to display 
the Workpaper Notes dialog box.

The Workpaper Reference list box lists all Workpaper Reference Codes currently in 
the Trial Balance grid. Clicking on a code in the list displays all accounts associated 
with the code in the Associated Accounts list box.

Adding an Account to a Workpaper Reference Code
1. On the Ledger menu, click Workpaper Notes.

2. Select Add Account to assign an account to the selected Workpaper Reference 
Code. A dialog box appears, listing all the accounts on the Trial Balance grid.

3. Select the account to which you would like to assign a Workpaper Reference Code, 
and select Use Account.

4. Upon changing your view to another Workpaper Reference Code or closing the 
dialog box, your changes are saved automatically. The Trial Balance grid is 
updated automatically with the new Workpaper Reference Code’s information.

5. Select Done when you have finished adding and modifying notes. 

Removing an Account from a Workpaper Reference Code
1.  Select the account in the Associated Accounts list box.

2. Select Remove Account to unassign an account.

3. Your changes are saved automatically. The Trial Balance grid is updated 
automatically with the new Workpaper Reference Code’s information. You may 
also delete the Workpaper Reference Code for a particular account on the Trial 
Balance grid itself.

4. Select Done when you have finished adding and modifying notes.

Viewing the Workpaper Reference Codes
1. Select Prior and Next to scroll through the Workpaper Reference Codes and 

display the associated accounts and note with each code. 

2. If changes are made to the existing Workpaper Reference Code’s note, you are 
prompted to save changes before displaying the information associated with the 
prior or next Workpaper Reference Code.
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WORKPAPER REFERENCE CODES
Adding a Workpaper Reference Code
1. Select New to add a new Workpaper Reference Code. The New Workpaper Code 

dialog box appears. 

2. Enter a new code and click OK to add it to the list box. The new code is 
highlighted so you can add accounts and a note associated with the new code.

Deleting a Workpaper Reference Code
Select Delete to delete a highlighted code from the list. A message informs you that all 
information associated with the code will also be deleted. The note is deleted as well as 
the Workpaper Reference Code from associated accounts. The accounts in the Trial 
Balance grid, however, are unaffected except for the deletion of the Workpaper 
Reference Code. 
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VIEWING DATA IN TAX FORMAT
Viewing Data in Tax Format

 You can view bridged data in tax return format. On the View menu, click Tax 
Summary. You must make your changes by accessing the Trial Balance Grid screen, 
through journal entries, or by changing the source file and re-importing. 

Accessing Journal Entry Detail
1.  On the Account Detail dialog box, access the Journal Entry Detail by double-

clicking a journal entry in the list box. 

2. Changes you make to the journal entry cause a calculation and update the Tax 
Summary detail when you close the Journal Entry Detail dialog box.
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REPORTS: PRINT AND PRINT PREVIEW
Reports: Print and Print Preview

 The following reports are available to preview or print: 

• Adjusting Journal Entries 
• Workpaper Notes 
• G/L Account Sequence 
• Detail:

• Taxable Income Detail 
• Taxable Income Variance Detail 
• Balance Sheet Detail 
• Schedule M-1 Detail 
• Schedule M-1 Variance Detail 
• Rental Real Estate Property Detail 
• Other Rental Property Detail
• Royalty Property Detail
• Farm Property Detail
• Schedule M-3 Detail

• Summary:
• Taxable Income Summary 
• Taxable Income Variance Summary 
• Balance Sheet Summary 
• Schedule M-1 Summary 
• Schedule M-1 Variance Summary 
• Schedule M-2 Summary 
• Rental Real Estate Property Summary
• Rental Real Estate Summary
• Other Rental Property Summary
• Other Rental Summary 
• Royalty Property Summary 
• Royalty Summary 
• Farm Property Summary
• Farm Summary 
• TRC and TCC Summary 
• Schedule M-3 Summary
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Taxable Income Detail and Balance Sheet Detail Reports
On the Balance Sheet: Detail and Income Statement: Detail Reports, details of each 
account are categorized by TRC/TCC and displayed in tax form format. The 
workpapers contain TCC subtotals and TRC grand totals. These amounts are printed:

• Prior-Year Balance (Income Statement must check option for this to display.)
• Balance per Book
• Book Adjusting Journal Entries
• Adjusted Book Balance
• Tax Adjustments (tax reclassification and M-1 entries)
• Final Tax Balance.

Taxable Income Summary
The Taxable Income Summary presents the totals of all accounts for each TRC. The 
Taxable Income Summary is displayed according to the line numbers on the form. The 
following amounts are printed:

• Prior-Year Balance (must check option for this to display)
• Balance Per Book
• Adjusted Book Balance
• Tax Adjustments (totals for tax reclassification and M-1 entries)
• Final Tax Balance.

Taxable Income Variance Detail and Schedule M-1
Variance Detail Reports

The Taxable Income Variance: Detail and Schedule M-1 Variance: Detail Reports 
compare the difference between prior year balance and the current year balance for 
each account. Accounts are categorized by TRC/TCC and displayed in tax form 
format. The workpapers display TCC subtotals and TRC grand totals. These amounts 
are printed:

• Prior Year Final Tax Balance
• Current Year Final Tax Balance
• Difference
• Percent Change.

Note:
This report is printed in Landscape format only.
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Taxable Income Variance Summary and Schedule M-1
Variance Summary Reports

The Taxable Income Variance: Summary and Schedule M-1 Variance: Summary 
Reports compare the difference between prior year and current year totals of all 
accounts for each TRC. The reports are displayed according to the line numbers on the 
form. These amounts are printed:

• Prior Year Final Tax Balance
• Current Year Final Tax Balance
• Difference
• Percent Change.

Note:
This report is printed in landscape format only.

Balance Sheet Summary
The Balance Sheet Summary presents the totals of all accounts for each TRC. The 
balance sheet is displayed according to the line numbers on the form. The following 
amounts are printed:

• Prior-Year Balance
• Balance per Book
• Book Adjusting Journal Entries (totals)
• Adjusted Book Balance
• Tax Adjustments (totals for tax reclassification and M-1 entries)
• Final Tax Balance.

Schedule M-1 Detail
The Schedule M-1 Detail presents the total of all accounts for each account categorized 
by TRC/TCC and displayed in tax form format. The reports contain TCC subtotals and 
TRC grand totals. The following amounts are printed:

• Book Balance
• Book Adjusting Journal Entries
• Adjusted Book Balance
• Tax Adjustments (tax reclassification and M-1 entries)
• Final Tax Balance.
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Schedule M-1 Summary
The Schedule M-1 Summary presents the totals of all accounts for each TRC. The 
Schedule M-1 Summary is displayed according to the line numbers on the form. The 
following amounts are printed:

• Balance per Book
• Book Adjusting Journal Entries (totals)
• Adjusted Book Balance
• Tax Adjustments (totals for tax reclassification and M-1 entries)
• Final Tax Balance.

Schedule M-2 Summary
Reports for Schedule M-2, Analysis of Partners’ Capital Accounts for 1065 and 
Analysis of Unappropriated Retained Earnings for all 1120 return types, print in 
summary form. The M-2 is available on portrait orientation only.

Adjusting Journal Entries
On the Adjusting Journal Entries workpaper, detail for each journal entry is shown. 
Journal entries are listed by type:

• Book Adjustments 
• Tax Reclassifications 
• Schedule M-1 Adjustments. 

Accounts and Details Affecting Journal Entry
All accounts and details affecting a journal entry are shown. These amounts are 
printed:

• Debits
• Credits
• Assets
• Liabilities and Equity
• Income
• Expense
• Schedule M-1
• Journal Entry Memos

Journal Entry Memos print immediately following the Adjusting Journal Entries. 
Journal Entries and Journal Entry Memos are available on landscape orientation only.
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Workpaper Notes
Workpaper Reference Codes print with the associated accounts in the detailed reports. 
The notes for that code print immediately following the detailed report. 

You can also elect to preview and/or print the Workpaper notes only by highlighting 
Workpaper Notes on the Preview or Print dialog box and clicking OK. 

Notes:
• The default paper size print setting for workpapers is 8 ½ inches by 11 inches.
• Trial Balance Bridge supports Windows printers and Form writers. Set up printers 

using Manager. On the File menu, select Print Setup. Detailed instructions are 
available in the Getting Started Guide.

G/L Account Sequence
The General Ledger Account Sequence presents a total of all accounts. This report 
displays a listing of every account with its description, TRC, and TCC. The following 
amounts are printed:

• Prior Year Balance
• Book Balance
• Book Adjusting Journal Entries
• Adjusted Book Balance
• Tax Adjustments (tax reclassification and M-1 entries)
• Final Tax Balance.

TRC and TCC Summary
The TRC and TCC Summary contains each TRC and its corresponding TCCs. The 
following items are printed:

• TRC
• TCC
• TCC Description

Schedule M-3 Detail
The Schedule M-3 Detail lists all lines of Part II and Part III of the M-3 with line item 
references, descriptions, MRC, MCC, and TRC codes assigned for that particular tax 
return. The following amounts print:

• Column (a) Income (Loss) per income statement
• Column (b) Temporary differences
• Column (c) Permanent differences
• Column (d) Income (Loss) per Tax Return.
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Schedule M-3 Summary
The Schedule M-3 Summary lists all lines and line descriptions with total balance for 
each line of Part II and Part III of the M-3. The following amounts print:

• Column (a) Income (Loss) per income statement
• Column (b) Temporary differences
• Column (c) Permanent differences
• Column (d) Income (Loss) per Tax Return.

Rental Real Estate, Other Rental, Royalty, and Farm Property Detail
Reports for Rental Real Estate: Property Detail, Other Rental: Property Detail, 
Royalty: Property Detail, and Farm: Property Detail present the totals for all accounts 
for each TRC. The following amounts are printed:

• Book Balance
• Book Adjusting Entries 
• Adjusted Book Balance
• Tax Adjustments (tax reclassification and M-1 entries)
• Final Tax Balance.

Rental Real Estate, Other Rental, Royalty, and Farm Property 
Summary

Reportsfor Rental Real Estate: Property Summary, Other Rental: Property Summary, 
Royalty: Property Summary, and Farm: Property Summary present information on a 
property-by-property basis, by the line numbers on the government form. The 
following amounts are printed:

• Book Balance
• Book Adjusting Entries (totals)
• Adjusted Book Balance
• Tax Adjustments (totals for tax reclassification and M-1 entries)
• Final Tax Balance.

Rental Real Estate, Other Rental, Royalty, Farm Summary
Reports for Rental Real Estate: Summary, Other Rental: Summary, Royalty: Summary, 
and Farm: Summary present the totals of all properties, by the line numbers on the 
government form. The following amounts are printed:

• Book Balance
• Book Adjusting Entries (totals)
• Adjusted Book Balance
• Tax Adjustments (totals for tax reclassification and M-1 entries)
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• Final Tax Balance.

Previewing Before Printing
1. On the File menu, select Print Preview. A list of available reports appears.

2. Select the report that you want to preview. The Preview what list box lists all 
reports available to view for the particular tax return type. 

3. Select the orientation you need, either Portrait or Landscape. The default is 
landscape. 
Note: Adjusting Journal Entries previews only on landscape and Schedule M-2 
previews only on portrait. For example, Adjusting Journal Entries and G/L 
Account Sequence only preview on landscape, and the M-2 Summary and TRC 
Summary only preview on portrait.

4. Select Suppress Lines with Zero Balance if you only want to preview accounts 
with balances.

5. To include the prior year balance on the taxable income reports, select the Include 
PYB on Taxable Income Reports check box.

6. You can include format options such as background shading or small font by 
selecting the Include Shading in Background or Use Small Font check boxes.

7. Click the Preview button to preview or the Cancel button to close the dialog box 
and return to the Trial Balance Grid screen.

Printing a Trial Balance Report
1. On the File menu, select Print. A list of available reports appears.

2. Select the workpapers you want to print.

3. Select the print orientation you need, either Portrait or Landscape. The default 
paper size for printing is 8 ½ inches by 11 inches with a Landscape orientation. 
You can change the orientation to portrait by clicking the Portrait option. Some 
workpapers have only one orientation.

Note:
Adjusting Journal Entries and G/L Account Sequence only print on landscape, and 
Schedule M-2 and TRC Summary only print on portrait.

4. You also have the option to print multiple reports at a time. Simply click and drag 
to highlight multiple reports, or click the Ctrl button as you select each report to 
print. Then click Print.

5. Select Suppress Lines with Zero Balance if you only want to print accounts with 
balances.

6. To include the prior year balance on the taxable income reports, select the Include 
PYB on Taxable Income Reports check box.
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PRINTING A TRIAL BALANCE REPORT
7. You can include format options such as background shading or small font by 
selecting the Include Shading in Background or Use Small Font check boxes.

8. Select the number of copies of the reports you want to print. To print multiple 
copies of the report, click each report to print and select the number of copies you 
want.

9. Select Print to File to have the reports print to a file instead of directly to a printer.

10. Click the Print button. To close the dialog box and cancel printing, select Cancel.
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CHANGES FOR 2007
Changes for 2007

New TRC Format
The new XX-XXX TRCs have been implemented. Please refer to our Product 
Assistance website for the “2007 Tax Year TRC List Reference Guide” for cross-
reference between the old and the new TRCs or refer to Help for side-by-side listings 
of the old/new TRCs.

TAXnnn account
As TRCs have expanded, the TAX accounts must now be entered as TAXnn-nnn 
instead of TAXnnn in a journal entry for TRCs to be assigned to the accounts 
automatically.

Performance
Scrolling speed in RS Trial Balance Bridge main screen has been improved. Scrolling 
with the scroll-up and scroll-down buttons requires shorter refresh time now. The 
screen refresh speed has also been improved when you move across a large section of 
your chart by the dragging the scrollbar’s scroll button, or by using the keyboard’s 
Page Up and Page Down keys and the Up and Down Arrow keys.

Rollover
Existing TRCs in your 2006 Trial Balance will be converted to the new TRC format 
automatically as binders are rolled over.

Partner Bridge Information
 The Partner Bridge is part of the 1065 product. For more information on Partner 
Bridge, see Using Partner Bridge on the 1065 Help Contents tab. 

Shareholder Bridge Information
 The Shareholder Bridge is part of the 1120 product. For more information on 
Shareholder Bridge, see Using Shareholder Bridge on the 1120 Help Contents tab.

Net Income Per Books
Trial Balance Bridge uses the following method to calculate Net Income per Books:

• Add the Adjusted Book Balance of all 30- and 40- category TRCs.
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M-3 COMPANY DETAIL
M-3 Company Detail
To review the M-3 company detail on the trial balance grid:
1. Select the Ledger Menu.

2. Select Sch. M-3 Company Reconciliation, from the drop down menu. Schedule 
M-3 Line Detail window appears.

3. There are two distinct screens, one on top the other on the bottom: On the top 
screen are the Account Details related to the accounts that have been mapped 
through the MRC to one of the lines that require company detail on Part II of 
Schedule M-3.

This information is coming from the Trial Balance and is editable from this screen. 
The top screen totals all of the account book balances, after Tax Reclass entries 
and Temporary and Permanent differences of all the accounts mapped to the MRC 
and Line Descriptions displayed at the top of the Window. When this information 
is merged into the tax application, the totals on the top screen appear on the 
Organizer screen under Sch M-3, Part II.

The following table shows the Schedule M-3 lines that are eligible for detail amounts.

Part II: Income/Loss Items and Part III: Expense Deduction Items 

Line Line Description MCC 
Detail

Cross-tie 
Required

1120

Part 11 1-12 Special Detail

Part 11 23f Worthless stock losses X

Part 11 25 Other income (loss) items with 
differences

X X

Part 11 28 Other items with no differences X

Part 111 35 Other expense/deduction items 
with differences

X X

1120S

Part 11 1-12 Special Detail

Part 11 21f Worthless stock losses X

Part 11 22 Other income (loss) items with 
differences

X

Part 11 25 Other items with no differences X

Part 111 29 Other expense/deduction items 
with differences

X
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M-3 COMPANY DETAIL
To change MRC and Line Description:
1. Select the drop down box. The available MRC codes and descriptions will appear.

2. Select the MRC Account to review or reconcile. Temporary and Permanent 
differences are from the M-1/M-3 Journal Entries. Whether you selected a 
Temporary or Permanent AJE determines how the account detail appears. All 
journal entries must use account numbers that have been mapped to the M-3 
Return Code (MRC) in order to be reflected in the Schedule M-3 Company 
Reconciliation.

The Bottom Screen
The bottom screen reflects the Company Details that were imported (“Importing” on 
page 16) from a user-defined file through Import M-3 Company Detail. You can also 
edit the information on the bottom of the screen. The line for which the Company 
Details are displayed is selected from the drop-down box at the top of the screen. 

To change the MRC and line description:
1. Select the drop-down box and select the MRC Line Description that you want to 

review or reconcile.

2. The last line reflects the difference between account detail for Balance, Temporary 
Difference, and Permanent Difference. The difference should be zero. If not, 
review your account detail balances and journal entries or change your import files 
of company detail.

3. If you change the import file we recommend that you Delete Contents and Delete 
Company Information, prior to importing the revised Company Detail import 
file.

1065

Part 11 1-10 Special Detail

Part 11 21F Worthless stock losses X

Part 11 22 Other income (loss) items with 
differences

X

Part 11 25 Other items with no differences X

Part 111 29 Other expense/deduction items 
with differences

X

Line Line Description MCC 
Detail

Cross-tie 
Required
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M-3 COMPANY DETAIL
The above procedure must be completed so that when the M-3 is merged into the Tax 
Return Lines on Schedule M-3 Part II, Company Detail will be populated. When 
merged into the tax application, the information on the bottom of the screen appears on 
the Organizer screen under Sch M-3, Part II, Detail.Otherwise you will have to 
manually enter this information in the Organizer. Prior to merging review Merge 
Defaults to see that M-3 data will be merged into Organizer.
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PRINTING
The following How Do I? Questions are current for this tax year. For more 
information, select How Do I from the Help menu to access this help system for the 
current release.

Printing
Can I prevent zero-balance accounts from printing?
 Yes. 

1. On the File menu, select Print or Print Preview.

2. Select the Suppress Lines with Zero Balance option. Please note that tax line 
item totals ALWAYS print.

Note:
This does not include the Journal Entry reports. Journal entries that contain zero 
balances are included in the Journal Entry reports.

Can I print Trial Balance Bridge workpapers to a file?
 Yes.

1. On the File menu, select Print.

2. Select the Print to File option.

3. Click Print.

4. On the Print to File dialog box, enter the drive\path\filename.

5. Select OK.

Why did the last column of the Trial Balance Bridge workpapers not print 
correctly?
 After printing the Trial Balance Bridge workpapers, I noticed that the last column does 
not appear on the printed copy. How can I correct this?

Solution: To print the Trial Balance Bridge workpapers correctly, select one of the 
following options:

• Refer to theTTA-supported printers described in the Getting Started Guide.
—or—

• Select the Use Small Font print option from the Print Trial Balance Reports 
window.
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IMPORTING AND MERGING
Importing and Merging

Can I import data from a package that is not listed?
 The pre-defined import templates do not contain my general ledger or audit package. 
Can I import from a package that is not listed?

Yes. Export the information from your G/L or audit package, and convert the export 
file to a spreadsheet format (.xls or .dif). Then, you can import the spreadsheet file into 
Trial Balance by using the User-Defined import template feature.

How can I make sure that all the Detailed Items get merged?
 After merging Trial Balance data into the organizer, I noticed that the detail items are 
merging as one lump sum/total instead of separate line items. What can I select to 
merge the detail line items? 

Solution: 

1. From within Trial Balance, on the Options menu, select Merge Defaults. 

2. Click the appropriate form or tab. 

3. Select the check box next to each item that you want to merge to Organizer.

Resolving Errors
How do I correct an installation error message?
 When I try to access Trial Balance, I receive the following error message “Application 
not properly installed!” 

Solution: Make sure that Trial Balance has been installed on your computer. If the 
problem persists, contact Technical Support.

If the data is damaged, can I save my data and start over?
 Sometimes! Depending upon the nature of actions taken by the user while working 
within Trial Balance Bridge, the following procedure often rectifies such a situation: 

1. Export all data (Trial Balance, Journal Entries and TCC Descriptions). 

2. On the File menu, select Delete Contents, then Delete All Contents. 

3. Re-import each exported file. 

Why do I get an “Unable to open coa file” error message?
 When I try to access Trial Balance Bridge, I get the error message “Unable to open coa 
file.” How can I successfully launch Trial Balance?

Sometimes the error message indicates a sharing violation. The Tax application 
assumes that the Trial Balance application is already open. Rebooting the machine will 
allow all the files to close properly and should allow you to launch Trial Balance 
successfully. If the problem persists, contact Technical Support.
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UNDERSTANDING RETURN TYPES
Understanding Return Types
How do I change return types in Trial Balance Bridge?
 Return type is set in Manager. There are two types: “C” for Corporation (either C-corp 
or S-corp) or “P” for Partnership. If a return does not want to accept certain TRCs, 
check in Manager to make sure that the return type is set. The following is excerpted 
from another tip regarding “Return Type not Supported.”

1. From the Tax Register View menu, change the Details option to include “Return 
Type.” This shows the return type for each locator. 

2. If the return type does not appear, you receive an error message that says “Return 
Type not Supported” when trying to access Trial Balance.

3. To set the return type, perform a full compute and then exit the tax application to 
return to the Tax Register. At that point, you should see a return type for the 
locator.

4. Open the tax application again. 

5. On the Access menu, select Trial Balance to access Trial Balance Bridge.
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TRC CATEGORIES
TRC Categories

Note:
Forms with updated TRCs will be available after the IRS finalizes all forms 
shown in this guide.

Category Name Specific Sub-Category Category/Range

Asset 10 to 19

Liability 20 to 29

Income 30 to 39

Operating Income 30

Non-operating Income 31

Activity Income 38

Deductions 40 to 49

Operating Deductions 40

Non-operating Deductions 41

Schedule K Deductions 44

Activity Deductions 48

Schedule M-1 60

Schedule M-2 62
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1065 TAX RETURN CODES
1 0 6 5  TA X  R E T U R N  C O D E S

Form 1065

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

105 Inventories (Farm) Page 4, Line 3 10-301

106 Inventories Page 4, Line 3 10-300

108 U.S. Government Obligations Page 4, Line 4 10-400

110 Tax Exempt Securities Page 4, Line 5 10-500

111 Other Tax Exempt Securities Page 4, Line 5 10-510

112 Other Current Assets X Page 4, Line 6 10-900

116 Mortgage and Real Estate Loans Page 4, Line 7 11-200

118 Other Investments X Page 4, Line 8 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 9a 11-500

122 Accumulated Depreciation Page 4, Line 9b 11-505

124 Depletable Assets Page 4, Line 10a 11-600

126 Accumulated Depletion Page 4, Line 10b 11-605

128 Land (Net of Amortization) Page 4, Line 11 11-700

130 Intangible Assets: Other Page 4, Line 12a 11-830

132 Accumulated Amortization Page 4, Line 12b 11-835

134 Other Assets X Page 4, Line 13 11-900

Page 4: Schedule L, Liabilities and Capital

200 Accounts Payable Page 4, Line 15 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 16 20-200

204 Other Current Liabilities X Page 4, Line 17 20-300

211 Non-Recourse Loans X Page 4, Line 18 20-250

212 Long-Term Mortgages, Notes and Bonds 
Payable

Page 4, Line 19 21-200

213 Qualified Non-Recourse Loans X Page 4, Line 18 20-555

214 Other Liabilities X Page 4, Line 20 21-300

230 Partners' Capital Page 4, Line 21 22-500
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1065 TAX RETURN CODES
Page 1: Income

300 Gross Receipts or Sales Page 1, Line 1a 30-100

302 Returns and Allowances Page 1, Line 1b 30-105

315 Ordinary Income (Loss) from Fiduciary Entities Page 1, Line 4 31-640

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 6 31-660

318 Other Income X Page 1, Line 7 31-900

Page 1: Deductions

415 Guaranteed Payments to Partners Page 1, Line 10 41-230

416 Salaries and Wages Page 1, Line 9 41-220

411 Employment Credits Page 1, Line 9 41-221

418 Repairs and Maintenance Page 1, Line 11 41-260

420 Bad Debts Page 1, Line 12 41-300

422 Rents Page 1, Line 13 41-350

424 Taxes and Licenses X Page 1, Line 14 41-420

428 Interest X Page 1, Line 15 41-500

433 Meals and Entertainment Page 1, Line 20 41-810

434 Depreciation Page 1, Line 16c 41-540

436 Depletion Page 1, Line 17 41-560

441 Retirement Plans Page 1, Line 18 41-570

442 Employee Benefit Programs Page 1, Line 19 41-620

443 Amortization Page 1, Line 20 41-820

444 Other Deductions X Page 1, Line 20 41-900

Page 2: Schedule A, COGS, COPS

400 COPS: Other Costs Page 2, Line 5 40-250

401 COPS: Depreciation Page 2, Line 5 40-260

402 COGS: Beginning Inventory Page 2, Line 1 40-110

404 COGS: Purchases Page 2, Line 2 40-120

405 COGS: Materials and Supplies Page 2, Line 5 40-122

406 COGS: Cost of Labor Page 2, Line 3 40-130

407 COGS: Additional Sec. 263A Costs X Page 2, Line 4 40-140

408 COGS: Other Costs X Page 2, Line 5 40-150

410 COGS: Depreciation Page 2, Line 5 40-160

412 COGS: Ending Inventory Page 2, Line 7 40-190

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
Page 3: Schedule K, Income

304 Sch K: Interest Income on U.S. Obligations X Page 3, Line 5 34-300

305 Sch K: Other Interest Income X Page 3, Line 5 34-310

306 Sch K: Other Dividend Income X Page 3, Line 6a 34-419

310 Sch K: Qualified Dividend Income (Investment) X Page 3, Line 6b 34-410

320 Sch K: Other Portfolio Income (Loss) X Page 3, Line 11 34-710

322 Sch K: Net Short-Term Capital Gain (Loss) Page 3, Line 8 34-500

324 Sch K: Net Long-Term Capital Gain (Loss) Page 3, Line 9a 34-550

325 Sch K: Guaranteed Payments to Partners Page 3, Line 4 34-200

326 Sch K: Net Gain (Loss) Under Section 1231 Page 3, Line 10 34-600

327 Sch K: Net Involuntary Conversion Gain (Loss) Page 3, Line 11 34-740

338 Sch K: Special Allocated Net Ordinary Gain 
(Loss)

Page 3, Line 11 34-750

340 Sch K: Other Income X Page 3, Line 11 34-800

Page 3: Schedule K, Rental Property Income

334 OR: Gross Rents Page 3, Line 3a 38-500

336 OR: Other Income Page 3, Line 3a 38-509

Page 3: Schedule K, Other Rental Property, Expenses

475 OR: Advertising Page 3, Line 3b 48-550

476 OR: Auto and Travel Page 3, Line 3b 48-553

477 OR: Cleaning and Maintenance Page 3, Line 3b 48-556

478 OR: Commissions Page 3, Line 3b 48-559

479 OR: Insurance Page 3, Line 3b 48-562

480 OR: Legal and Other Professional Fees Page 3, Line 3b 48-565

481 OR: Interest Page 3, Line 3b 48-568

482 OR: Repairs Page 3, Line 3b 48-571

484 OR: Taxes Page 3, Line 3b 48-574

485 OR: Utilities Page 3, Line 3b 48-577

486 OR: Wages and Salaries Page 3, Line 3b 48-580

488 OR: Other Expenses Page 3, Line 3b 48-599

489 OR: Depreciation Page 3, Line 3b 48-583

490 OR: Amortization Page 3, Line 3b 48-586

492 OR: Deductible Guaranteed Payments Page 3, Line 3b 48-589

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
Page 3: Schedule K, Royalty Property, Income

311 ROY: Gross Royalties Page 3, Line 7 38-300

331 ROY: Other Income Page 3, Line 7 38-309

Page 3: Schedule K, Royalty Property, Expenses

473 ROY: Depletion Page 3, Line 13d 48-360

474 ROY: Other Expenses Page 3, Line 13d 48-399

491 ROY: Investment Interest Expense Page 3, Line 13b 48-370

Page 3: Schedule K, Deductions

341 Sch K: Interest Expense on Investment Debts Page 3, Line 13b 44-500

413 Sch K: Payments for Partners: IRA Page 3, Line 13d 44-610

414 Sch K: Payments for Partners: Keogh Plan Page 3, Line 13d 44-620

417 Sch K: Payments for Partners: SEP Page 3, Line 13d 44-630

419 Sch K: Miscellaneous Deductions X Page 3, Line 13d 44-800

431 Sch. K: Capital Gain Property (20%) Page 3, Line 13a 44-450

435 Sch K: Charitable Contributions: Cash (30%) Page 3, Line 13a 44-410

446 Sch K: Charitable Contributions: Cash (50%) Page 3, Line 13a 44-400

437 Sch K: Charitable Contributions: Non-Cash 
(50%)

Page 3, Line 13a 44-420

438 Sch K: Charitable Contributions: Non-Cash 
(30%)

Page 3, Line 13a 44-430

448 Sch K: Section 179 Expense Deduction Page 3, Line 12 44-300

450 Sch K: Deductions Related to Portfolio Income X Page 3, Line 13d 44-530

453 Sch K: Section 59(e) Expenditures X Page 3, Line 13c 
(2)

44-520

430 Sch. K: Capital Gain Property to a 50% Org. 
(30%)

Page 3, Line 13a 44-440

Page 3: Foreign Transactions

454 Sch K: Foreign Taxes Page 3, Line 16l 
(1)

44-910

Page 4: Schedule M-1, Book Expenses Not Deducted on Reurn

604 Other Taxable Income Not Recorded on Books Page 4, Line 2 60-150

605 Guaranteed Payments Page 4, Line 3 60-120

606 Book Over Tax Depreciation Page 4, Line 4a 60-210

608 Book Over Tax Travel and Entertainment Page 4, Line 4b 60-216

610 Book Over Tax Depletion Page 4, Line 4b 60-222

614 Book Over Tax Amortization Page 4, Line 4b 60-224

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
Schedule F

617 Nondeductible Expenses Included on 
Schedule K

X Page 4, Line 4b 60-530

618 Other Book Expenses Not Deducted on Return X Page 4, Line 4b 60-240

Page 4, Schedule M-1, Book Income Not Included on Return

620 Tax-Exempt Interest Page 4, Line 6a 60-410

624 Other Book Income Not Included on Return X Page 4, Line 6a 60-450

Page 4, Schedule M-1, Tax Deductions Not Recored on Books

626 Tax Over Book Depreciation Page 4, Line 7a 60-510

630 Tax Over Book Depletion Page 4, Line 7a 60-522

634 Tax Over Book Amortization Page 4, Line 7a 60-524

638 Other Tax Deductions Not Recorded on Books X Page 4, Line 7a 60-540

Page 4: Schedule M-2, Analysis of Partners’ Capital Accounts

704 Capital Contributions X Page 4, Line 2a 62-304

700 Other Increases X Page 4, Line 4 62-300

702 Other Decreases X Page 4, Line 7 62-302

706 Distributions: Property X Page 4, Line 6b 62-306

708 Distributions: Cash Page 4, Line 6a 62-308

 2006 TRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC

Page 1: Farm Income - Cash Method
307 Farm: Sales of Livestock Bought for Resale 

(Cash)
Line 1 38-100

308 Farm: Cost or Basis of Livestock (Cash) Line 2 48-102
309 Farm: Sales of Livestock Raised (Cash) Line 4 38-104
313 Farm: Cooperative Distributions (Cash) Line 5a & 5b 38-106
317 Farm: Agricultural Program Payments (Cash) Line 6a & 6b 38-108
319 Farm: Commodity Credit Corp. Loans 

Reported (Cash)
Line 7a 38-110

323 Farm: Commodity Credit Loans Forfeited 
(Cash)

Line 7b & 7c 38-112

329 Farm: Crop Insurance in Current Year (Cash) Line 8a & 8b 38-114
333 Farm: Crop Insurance Proceeds Deferred 

(Cash)
Line 8d 38-116

337 Farm: Custom Hire (Machine Work) Income 
(Cash)

Line 9 38-118

339 Farm: Other Income (Cash) Line 10 38-120

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
Page 2: Farm Income - Accrual Method
342 Farm: Sales of Livestock and Other (Accrual) Line 38 38-130
344 Farm: Cooperative Distributions (Accrual) Line 39a & 39b 38-132
346 Farm: Agricultural Program Payments 

(Accrual)
Line 40a & 40b 38-134

347 Farm: Commodity Credit Loans Reported 
(Accrual)

Line 41a 38-136

349 Farm: Commodity Credit Loans Forfeited 
(Accrual)

Line 41b & 41c 38-138

350 Farm: Crop Insurance Proceeds (Accrual) Line 42 38-140
351 Farm: Custom Hire (Machine Work) Income 

(Accrual)
Line 43 38-142

352 Farm: Other Income (Accrual) Line 44 38-150
353 Farm: Beginning Inventory (Accrual) Line 46 48-170
357 Farm: Cost of Livestock Purchased (Accrual) Line 47 48-173
359 Farm: Ending Inventory (Accrual) Line 49 48-176

Page 1: Farm Expenses - Cash and Accrual Method
403 Farm: Car and Truck Expenses Line 12 48-200
409 Farm: Chemicals Line 13 48-203
421 Farm: Custom Hire/Machine Work Line 15 48-209
423 Farm: Conservation Expenses Line 14 48-206
425 Farm: Depreciation Line 16 48-212
427 Farm: Employee Benefits Line 17 48-215
429 Farm: Feed Purchased Line 18 48-218
432 Farm: Fertilizer and Lime Line 19 48-221
440 Farm: Freight and Trucking Line 20 48-224
447 Farm: Gasoline, Fuel, and Oil Line 21 48-227
449 Farm: Insurance Line 22 48-230
451 Farm: Mortgage Interest Line 23a and 

34a
48-236

452 Farm: Other Interest Line 23b 48-239
463 Farm: Supplies Purchased Line 30 48-263
467 Farm: Utilities Line 32 48-269
471 Farm: Labor Hired (Net) Line 24 48-242
483 Farm: Pension and Profit Sharing Line 25 48-245
487 Farm: Rent or Lease Machinery and 

Equipment
Line 26a 48-248

493 Farm: Rent or Lease Other (Land, Animals, 
etc.)

Line 26b 48-251

494 Farm: Repairs and Maintenance Line 27 48-254
495 Farm: Seeds and Plants Purchased Line 28 48-257
496 Farm: Storage and Warehousing Line 29 48-260

 2006 TRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
8825 

Schedule M-3

497 Farm: Taxes Line 31 48-266
498 Farm: Veterinary, Breeding, and Medicine Line 33 48-270
499 Farm: Other Expenses Line 34a 48-290

 2006 
MRC

DESCRIPTION DIVISIONAL 
DETAIL 

ROLLUP

FLOWS TO 
PAGE, LINE  2007 

TRC

Rental Real Estate Property: Income
330 RRE: Gross Rents Line 2 38-400

332 RRE: Other Income Line 2 38-409

Rental Real Estate Property: Expense
455 RRE: Advertising Line 3 48-450

456 RRE: Auto and Travel Line 4 48-453

457 RRE: Cleaning and Maintenance Line 5 48-456

458 RRE: Commissions Line 6 48-459

459 RRE: Insurance Line 7 48-462

460 RRE: Legal and Other Professional 
Fees

Line 8 48-465

461 RRE: Interest Line 9 48-468

462 RRE: Repairs Line 10 48-471

464 RRE: Taxes Line 11 48-474

465 RRE: Utilities Line 12 48-477

466 RRE: Wages and Salaries Line 13 48-480

468 RRE: Other Expenses Line 15 48-499

469 RRE: Depreciation Line 14 48-486

470 RRE: Amortization Line 15 48-489

472 RRE: Deductible Guaranteed Payments Line 15 48-492

 2006 
MRC

DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC

Part II – Income (Loss) Item
I100 Income (loss) from equity method foreign 

corporations
Page 2, Line 1 I100

I110 Gross foreign dividends not previously taxed Page 2, Line 2 I110
I120 Subpart F, QEF, and similar income inclusions Page 2, Line 3 I120
I140 Gross foreign distributions previously taxed Page 2, Line 4 I140

 2006 TRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
TRC
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1065 TAX RETURN CODES
I150 Income (loss) from equity method US 
corporations

Page 2, Line 5 I150

I160 US dividends not eliminated in tax 
consolidation

Page 2, Line 6 I160

I180 Income (loss) from US partnerships Page 2, Line 7 I180
I190 Income (loss) from foreign partnerships Page 2, Line 8 I190
I200 Income (loss) from other pass-through entities Page 2, Line 9 I200
I210 Items relating to reportable transactions Page 2, Line 10 I210
I220 Interest Income Page 2, Line 11 I220
I230 Total accrual to cash adjustment Page 2, Line 12 I230
I240 Hedging transactions Page 2, Line 13 I240
I250 Mark-to-market income (loss) Page 2, Line 14 I250
I270 Sale versus lease (for sellers and/or lessors) Page 2, Line 16 I270
I280 Section 481(a) adjustments Page 2, Line 17 I280
I290 Unearned / deferred revenue Page 2, Line 18 I290
I300 Income recognition from long-term contracts Page 2, Line 19 I300
I310 Original issue discount and other imputed 

interest
Page 2, Line 20 I310

I320 Income statement gain/loss on sale, 
exchange, abandonment, worthlessness, or 
other disposition of assets other than inventory 
and pass-through entities

Page 2, Line 21a I320

I330 Gross capital gains from Schedule D, 
excluding amount from pass-through entities

Page 2, Line 21b I330

I340 Gross capital losses from Schedule D, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 21c I340

I350 Net gain/loss reported on Form 4797, line 17, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 21d I350

I360 Abandonment losses Page 2, Line 21e I360
I370 Worthless stock losses Page 2, Line 21f I370
I380 Other gain/loss on disposition of assets other 

than inventory
Page 2, Line 21g I380

I410 Other income (loss) items with differences X Page 2, Line 22 I410
I420 Other items with no differences X Page 2, Line 25 I420

Part III – Expense/Deduction Items
E570 State and local current income tax expense Page 3, Line 1 E570
E580 State and local deferred income tax expense Page 3, Line 2 E580
E590 Foreign current income tax expense (other 

than foreign withholding taxes)
Page 3, Line 3 E590

E600 Foreign deferred income tax expense Page 3, Line 4 E600

 2006 
MRC

DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC
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1065 TAX RETURN CODES
8916-A Return Codes 

E640 Other equity-based compensation Page 3, Line 5 E640
E650 Meals and entertainment Page 3, Line 6 E650
E660 Fines and penalties Page 3, Line 7 E660
E670 Judgments, damages, awards, and similar 

costs
Page 3, Line 8 E670

E681 Guaranteed payments Page 3, Line 9 E681
E700 Pension and profit-sharing Page 3, Line 10 E700
E710 Other post-retirement benefits Page 3, Line 11 E710
E720 Deferred compensation Page 3, Line 12 E720
E730 Charitable contribution of cash and tangible 

property
Page 3, Line 13 E730

E740 Charitable contribution of intangible property Page 3, Line 14 E740
E762 Organizational expenses as per 1.709-2 (a) Page 3, Line 15 E762
E763 Syndication expenses as per 1.709-2 (b) Page 3, Line 16 E763
E770 Current year acquisition or reorganization 

investment banking fees
Page 3, Line 17 E770

E780 Current year acquisition or reorganization 
legal and accounting fees

Page 3, Line 18 E780

E800 Amortization / impairment of goodwill Page 3, Line 19 E800
E810 Amortization of acquisition, reorganization, 

and start-up costs
Page 3, Line 20 E810

E820 Other amortization or impairment write-offs Page 3, Line 21 E820
E830 Section 198 environmental remediation costs Page 3, Line 22 E830
E840 Depletion - oil & gas Page 3, Line 23a E840
E841 Depletion - other than oil & gas Page 3, Line 23b E841
E842 Intangible drilling & development costs Page 3, Line 24 E842
E850 Depreciation Page 3, Line 25 E850
E860 Bad debt expense Page 3, Line 26 E860
E621 Interest expense Page 3, Line 27 E621
E880 Purchase versus lease (for purchasers and/or 

lessees)
Page 3, Line 28 E880

E890 Other expense/deduction items with 
differences (attach schedule)Page 3, Line 15

X Page 3, Line 29 E890

 2006 MRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 MRC

I260.01 Amounts attributable to cost flow assumptions 1 I260.01
I260.02A Stock option expense 2a I260.02A
I260.02B Other equity based compensation 2b I260.02B
I260.02C Meals and entertainment 2c I260.02C
I260.02D Parachute payments 2d I260.02D

 2006 
MRC

DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC
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I260.02E Compensation with section 162(m) limitation 2e I260.02E
I260.02F Pension and profit sharing 2f I260.02F
I260.02G Other post-retirement benefits 2g I260.02G
I260.02H Deferred compensation 2h I260.02H
I260.02I Section 198 environmental remediation costs 2i I260.02I
I260.02J Amortization 2j I260.02J
I260.02K Depletion 2k I260.02K
I260.02L Depreciation 2l I260.02L
I260.02M Corporate owned life insurance premiums 2m I260.02M
I260.02N Other section 263A costs 2n I260.02N
I260.03 Inventory shrinkage accruals 3 I260.03
I260.04 Excess inventory and obsolescence reserves 4 I260.04
I260.05 Lower of cost or market write-downs 5 I260.05
I260.06 Other items with differences (attach schedule) 6 I260.06
I260.07 Other items with no differences 7 I260.07

 2006 MRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 MRC
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1120 TAX RETURN CODES
11 2 0  TA X  R E T U R N  C O D E S

Form 1120

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

106 Inventories Page 4, Line 3 10-300

108 U.S. Government Obligations X Page 4, Line 4 10-400

110 Tax Exempt Securities X Page 4, Line 5 10-500

112 Other Current Assets X Page 4, Line 6 10-900

114 Loans to Stockholders Page 4, Line 7 11-100

116 Mortgage and Real Estate Loans X Page 4, Line 8 11-200

118 Other Investments X Page 4, Line 9 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 10a 11-500

122 Accumulated Depreciation Page 4, Line 10b 11-505

124 Depletable Assets Page 4, Line 11a 11-600

126 Accumulated Depletion Page 4, Line 11b 11-605

128 Land (Net of Amortization) Page 4, Line 12 11-700

130 Intangible Assets: Other Page 4, Line 13a 11-830

132 Accumulated Amortization Page 4, Line 13b 11-835

134 Other Assets X Page 4, Line 14 11-900

Page 4: Schedule L, Liabilities & Equity

200 Accounts Payable Page 4, Line 16 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 17 20-200

204 Other Current Liabilities X Page 4, Line 18 20-300

206 Accrued Federal Income Tax X Page 4, Line 18 20-410

207 Federal Income Tax Deposits Paid X Page 4, Line 18 20-415

208 Accrued State and Local Income Tax X Page 4, Line 18 20-420

209 State and Local Income Tax Deposits Paid X Page 4, Line 18 20-425

210 Loans from Stockholders X Page 4, Line 19 21-100

212 Long-Term Mortgages, Notes, and Bonds 
Payable

Page 4, Line 20 21-200
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214 Other Liabilities X Page 4, Line 21 21-300

216 Capital Stock - Preferred Page 4, Line 22a 22-100

218 Capital Stock - Common Page 4, Line 22b 22-110

220 Additional Paid-In Capital X Page 4, Line 23 22-200

222 Retained Earnings - Appropriated X Page 4, Line 24 22-300

224 Retained Earnings - Unappropriated Page 4, Line 25 22-310

226 Adjustments to Shareholders’ Equity X Page 4, Line 26 22-400

228 Cost of Treasury Stock Page 4, Line 27 22-440

Page 1: Income

300 Gross Receipts or Sales Page 1, Line 1a 30-100

302 Returns and Allowances Page 1, Line 1b 30-105

304 Interest on U.S. Obligations Page 1, Line 5 31-340

306 Other Interest X Page 1, Line 5 31-380

308 Gross Rents Page 1, Line 6 31-420

310 Gross Royalties Page 1, Line 7 31-520

312 Net Farm Profit (Loss) Page 1, Line 10 31-662

314 Capital Gains (Schedule D) Page 1, Line 8 31-620

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 9 31-660

318 Other Income X Page 1, Line 10 31-900

Page 2: Schedule C, Dividends and Special Deductions

321 DIV: Debt-Financed Stock of Domestic/Foreign 
Corps

Page 2, Line 3 31-120

324 DIV: Wholly-Owned Foreign Subs Subject to 
100% Deduction

Page 2, Line 8 31-145

325 DIV: Affiliated Group Members Subject to 100% 
Deduction

Page 2, Line 11 31-155

326 DIV: Other Foreign Corporations Page 2, Line 13 31-165

327 DIV: Income from CFC Under Subpart F Page 2, Line 14 31-170

328 DIV: Foreign Dividend Gross-Up Page 2, Line 15 31-175

329 DIV: IC-DISC and Former DISC Page 2, Line 16 31-180

330 DIV: Other Dividends X Page 2, Line 17 31-185

331 DIV: Domestic Corporations Subject to 80% 
Deduction

Page 2, Line 2 31-115

332 DIV: Pref Stock of Less-Than-20%-Owned 
Public Utilities

Page 2, Line 4 31-125

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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333 DIV: Pref Stock of 20%-Or-More-Owned Public 
Utilities

Page 2, Line 5 31-130

334 DIV: 20%-Or-More-Owned For Corps/FSCs @ 
80%

Page 2, Line 7 31-140

335 DIV: Domestic Corporations Subject to 70% 
Deduction

Page 2, Line 1 31-110

336 DIV: Less-Than-20%-Owned For Corps/FSCs 
@ 70%

Page 2, Line 6 31-135

337 DIV: Certain FSCs Subject to 100% Deduction Page 2, Line 12 31-160

338 DIV: Domestic Corps Received by SBIC Under 
‘58 Act

Page 2, Line 10 31-150

Page 2: Schedule A, COGS, COPS

400 COPS: Other Costs X Page 2, Line 5 40-250

401 COPS: Depreciation Page 2, Line 5 40-260

402 COGS: Beginning Inventory Page 2, Line 1 40-110

404 COGS: Purchases Page 2, Line 2 40-120

406 COGS: Cost of Labor Page 2, Line 3 40-130

407 COGS: Additional Sec. 263A Costs Page 2, Line 4 40-140

408 COGS: Other Costs X Page 2, Line 5 40-150

410 COGS: Depreciation Page 2, Line 5 40-160

411 COGS: Amortization Page 2, Line 5 40-170

412 COGS: Ending Inventory Page 2, Line 7 40-190

413 COPS: Amortization Page 2, Line 5 40-270

Page 1: Deductions

414 Compensation of Officers Page 1, Line 12 41-210

415 Emploment Credits Page 1, Line 13 41-221

416 Salaries and Wages Page 1, Line 13 41-220

418 Repairs and Maintenance Page 1, Line 14 41-260

420 Bad Debts Page 1, Line 15 41-300

422 Rents Page 1, Line 16 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses X Page 1, Line 17 41-420

426 State and Local Taxes X Page 1, Line 17 41-460

428 Interest X Page 1, Line 18 41-500

430 Current Year Contributions X Page 1, Line 19 41-520

434 Depreciation Page 1, Line 20 41-540

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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436 Depletion Page 1, Line 21 41-560

438 Advertising Page 1, Line 22 41-580

439 Meals and Entertainment Page 1, Line 26 41-810

440 Pension, Profit-Sharing, etc. Plans Page 1, Line 23 41-600

441 100% Deductible Travel Page 1, Line 26 41-812

442 Employee Benefit Programs Page 1, Line 24 41-620

443 Amortization Page 1, Line 26 41-820

444 Other Deductions X Page 1, Line 26 41-900

458 Domestic Production Activities Deduction Page 1, Line 25 41-640

Page 4: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 4, Line 2 60-110

602 Excess Capital Loss Over Capital Gain Page 4, Line 3 60-130

603 Foreign Dividend Gross-Up Not on Books Page 4, Line 4 60-142

604 Other Taxable Income Not Recorded on Books X Page 4, Line 4 60-150

615 Tax Over Book Gain Page 4, Line 4 60-144

Page 4: Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 4, Line 5a 60-210

608 Book Over Tax State Taxes Page 4, Line 5c 60-221

610 Book Over Tax Depletion Page 4, Line 5c 60-222

612 Book Over Tax Bad Debts Page 4, Line 5c 60-223

613 Book Over Tax Employment Credit Wage 
Reduction

Page 4, Line 5c 60-226

614 Book Over Tax Amortization Page 4, Line 5c 60-224

616 Book Over Tax Contributions Page 4, Line 5b 60-213

617 Book Over Tax Travel and Entertainment Page 4, Line 5c 60-216

618 Other Book Expenses Not Deducted on Return X Page 4, Line 5c 60-240

620 Tax Exempt Interest Page 4, Line 7 60-410

622 Capital Loss Carryover Utilized Page 4, Line 8b 60-526

624 Other Book Income Not Included on Return X Page 4, Line 7 60-450

635 Book Over Tax Gain Page 4, Line 7 60-544

Page 4, Schedule M-1, Tax Deductions Not Recorded on Books

626  Tax Over Book Depreciation Page 4, Line 8a 60-510

628  Tax Over Book State Taxes Page 4, Line 8b 60-521

630  Tax Over Book Depletion Page 4, Line 8b 60-522

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
TRIAL BALANCE BRIDGE ONLINE GUIDE 89



1120 TAX RETURN CODES
Schedule M-3

632  Tax Over Book Bad Debts Page 4, Line 8b 60-523

634  Tax Over Book Amortization Page 4, Line 8b 60-524

636 Contribution Carryover Utilized Page 4, Line 8b 60-613

638 Other Tax Deductions Not Recorded on Books X Page 4, Line 8b 60-540

Page 4: Schedule M-2, Analysis of Unappropriated Retained Earnings

700 Other Increases X Page 4, Line 3 62-300

702 Other Decreases X Page 4, Line 6 62-302

706 Distributions: Property X Page 4, Line 5c 63-306

708 Distributions: Cash Page 4, Line 5a 62-308

710 Distributions: Stock Page 4, Line 5b 62-310

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE 2007 MRC

Part II – Income (Loss) Item
I100 Income (loss) from equity method foreign 

corporations
Page 2, Line 1 I100

I110 Gross foreign dividends not previously taxed Page 2, Line 2 I110
I120 Subpart F, QEF, and similar income inclusions Page 2, Line 3 I120
I130 Section 78 gross-up Page 2, Line 4 I130
I140 Gross foreign distributions previously taxed Page 2, Line 5 I140
I150 Income (loss) from equity method US 

corporations
Page 2, Line 6 I150

I160 US dividends not eliminated in tax 
consolidation

Page 2, Line 7 I160

I170 Minority interest for includible corporations Page 2, Line 8 I170
I180 Income (loss) from US partnerships Page 2, Line 9 I180
I190 Income (loss) from foreign partnerships Page 2, Line 10 I190
I200 Income (loss) from other pass-through entities Page 2, Line 11 I200
I210 Items relating to reportable transactions Page 2, Line 12 I210
I220 Interest Income Page 2, Line 13 I220
I230 Total accrual to cash adjustment Page 2, Line 14 I230
I240 Hedging transactions Page 2, Line 15 I240
I250 Mark-to-market income (loss) Page 2, Line 16 I250
I270 Sale versus lease (for sellers and/or lessors) Page 2, Line 18 I270
I280 Section 481(a) adjustments Page 2, Line 19 I280
I290 Unearned / deferred revenue Page 2, Line 20 I290
I300 Income recognition from long-term contracts Page 2, Line 21 I300
I310 Original issue discount and other imputed 

interest
Page 2, Line 22 I310

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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1120 TAX RETURN CODES
I320 Income statement gain/loss on sale, 
exchange, abandonment, worthlessness, or 
other disposition of assets other than inventory 
and pass-through entities

Page 2, Line 23a I320

I330 Gross capital gains from Schedule D, 
excluding amount from pass-through entities

Page 2, Line 23b I330

I340 Gross capital losses from Schedule D, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 23c I340

I350 Net gain/loss reported on Form 4797, line 17, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 23d I350

I360 Abandonment losses Page 2, Line 23e I360
I370 Worthless stock losses Page 2, Line 23f I370
I380 Other gain/loss on disposition of assets other 

than inventory
Page 2, Line 23g I380

I390 Capital loss limitation and carryforward used Page 2, Line 24 I390
I410 Other income (loss) items with differences X Page 2, Line 25 I410
I420 Other items with no differences X Page 2, Line 28 I420

Part III – Expense/Deduction Items
E550 US current income tax expense Page 3, Line 1 E550
E560 US deferred income tax expense Page 3, Line 2 E560
E570 State and local current income tax expense Page 3, Line 3 E570
E580 State and local deferred income tax expense Page 3, Line 4 E580
E590 Foreign current income tax expense (other 

than foreign withholding taxes)
Page 3, Line 5 E590

E600 Foreign deferred income tax expense Page 3, Line 6 E600
E610 Foreign withholding taxes Page 3, Line 7 E610
E621 Interest expense Page 3, Line 8 E621
E631 Stock option expense Page 3, Line 9 E631
E640 Other equity-based compensation Page 3, Line 10 E640
E650 Meals and entertainment Page 3, Line 11 E650
E660 Fines and penalties Page 3, Line 12 E660
E670 Judgements,damages, awards, and similar 

costs
Page 3, Line 13 E670

E680 Parachute payments Page 3, Line 14 E680
E690 Compensation with section 162(m) limitation Page 3, Line 15 E690
E700 Pension and profit-sharing Page 3, Line 16 E700
E710 Other post-retirement benefits Page 3, Line 17 E710
E720 Deferred compensation Page 3, Line 18 E720
E730 Charitable contribution of cash and tangible 

property
Page 3, Line 19 E730

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE 2007 MRC
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1120 TAX RETURN CODES
Form 8916-A Return Codes

E740 Charitable contribution of intangible property Page 3, Line 20 E740
E751 Charitable contribution limitation/carryforward Page 3, Line 21 E751
E761 Domestic production activities deduction Page 3, Line 22 E761
E770 Current year acquisition or reorganization 

investment banking fees
Page 3, Line 23 E770

E780 Current year acquisition or reorganization 
legal and accounting fees

Page 3, Line 24 E780

E790 Current year acquisition/reorganization other 
costs

Page 3, Line 25 E790

E800 Amortization / impairment of goodwill Page 3, Line 26 E800
E810 Amortization of acquisition, reorganization, 

and start-up costs
Page 3, Line 27 E810

E820 Other amortization or impairment write-offs Page 3, Line 28 E820
E830 Section 198 environmental remediation costs Page 3, Line 29 E830
E840 Depletion Page 3, Line 30 E840
E850 Depreciation Page 3, Line 31 E850
E860 Bad debt expense Page 3, Line 32 E860
E870 Corporate owned life insurance premiums Page 3, Line 33 E870
E880 Purchase versus lease (for purchasers and/or 

lessees)
Page 3, Line 34 E880

E890 Other expense/deduction items with 
differences

X Page 3, Line 35 E890

 2006 MRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 MRC

I260.01 Amounts attributable to cost flow assumptions 1 I260.01
I260.02A Stock option expense 2a I260.02A
I260.02B Other equity based compensation 2b I260.02B
I260.02C Meals and entertainment 2c I260.02C
I260.02D Parachute payments 2d I260.02D
I260.02E Compensation with section 162(m) limitation 2e I260.02E
I260.02F Pension and profit sharing 2f I260.02F
I260.02G Other post-retirement benefits 2g I260.02G
I260.02H Deferred compensation 2h I260.02H
I260.02I Section 198 environmental remediation costs 2i I260.02I
I260.02J Amortization 2j I260.02J
I260.02K Depletion 2k I260.02K
I260.02L Depreciation 2l I260.02L
I260.02M Corporate owned life insurance premiums 2m I260.02M
I260.02N Other section 263A costs 2n I260.02N
I260.03 Inventory shrinkage accruals 3 I260.03

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE 2007 MRC
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I260.04 Excess inventory and obsolescence reserves 4 I260.04
I260.05 Lower of cost or market write-downs 5 I260.05
I260.06 Other items with differences (attach schedule) 6 I260.06
I260.07 Other items with no differences 7 I260.07

 2006 MRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 MRC
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1120-C TAX RETURN CODES
11 2 0 - C  TA X  R E T U R N  C O D E S

Form 1120-C

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

2007 TRC

Page 5: Schedule L, Assets 

100 Cash Page 5, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 5, Line 2a 10-200

104 Allowance for Bad Debts Page 5, Line 2b 10-205

106 Inventories Page 5, Line 3 10-300

108 U.S. Government Obligations X Page 5, Line 5 10-400

110 Tax Exempt Securities X Page 5, Line 5 10-500

112 Other Current Assets X Page 5, Line 4 10-900

114 Loans to Stockholders Page 5, Line 6 11-100

116 Mortgage and Real Estate Loans X Page 5, Line 7 11-200

118 Other Investments X Page 5, Line 5 11-400

120 Buildings and Other Depreciable Assets Page 5, Line 8a 11-500

122 Accumulated Depreciation Page 5, Line 8b 11-505

124 Depletable Assets Page 5, Line 9a 11-600

126 Accumulated Depletion Page 5, Line 9b 11-605

128 Land (Net of Amortization) Page 5, Line 10 11-700

130 Intangible Assets: Other Page 5, Line 11a 11-830

132 Accumulated Amortization Page 5, Line 11b 11-835

134 Other Assets X Page 5, Line 12 11-900

Page 5: Schedule L, Liabilities & Equity

200 Accounts Payable Page 5, Line 14 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 5, Line 15 20-200

204 Other Current Liabilities X Page 5, Line 16 20-300

206 Accrued Federal Income Tax X Page 5, Line 16 20-410

207 Federal Income Tax Deposits Paid X Page 5, Line 16 20-415

208 Accrued State and Local Income Tax X Page 5, Line 16 20-420

209 State and Local Income Tax Deposits Paid X Page 5, Line 16 20-425

210 Loans from Stockholders X Page 5, Line 17 21-100

212 Long-Term Mortgages, Notes, and Bonds 
Payable

Page 5, Line 18 21-200
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214 Other Liabilities X Page 5, Line 19 21-300

216 Capital Stock - Preferred Page 5, Line 20a 22-100

218 Capital Stock - Common Page 5, Line 20b 22-110

220 Additional Paid-In Capital X Page 5, Line 21 22-200

222 Retained Earnings - Appropriated X Page 5, Line 24 22-300

224 Retained Earnings - Unappropriated Page 5, Line 25 22-310

226 Adjustments to Shareholders’ Equity X Page 5, Line 26 22-400

228 Cost of Treasury Stock Page 5, Line 27 22-440

Page 1: Income

300 Gross Receipts or Sales Page 1, Line 1a 30-100

302 Returns and Allowances Page 1, Line 1b 30-105

304 Interest on U.S. Obligations Page 1, Line 5 31-340

306 Other Interest X Page 1, Line 5 31-380

308 Gross Rents Page 1, Line 6 31-420

310 Gross Royalties Page 1, Line 6 31-520

312 Net Farm Profit (Loss) Page 1, Line 9 31-662

314 Capital Gains (Schedule D) Page 1, Line 7 31-620

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 8 31-660

318 Other Income X Page 1, Line 9 31-900

Page 2: Schedule C, Dividends and Special Deductions

321 DIV: Debt-Financed Stock of Domestic/Foreign 
Corps

Page 2, Line 3 31-120

324 DIV: Wholly-Owned Foreign Subs Subject to 
100% Deduction

Page 2, Line 8 31-145

325 DIV: Affiliated Group Members Subject to 100% 
Deduction

Page 2, Line 11 31-155

326 DIV: Other Foreign Corporations Page 2, Line 13 31-165

327 DIV: Income from CFC Under Subpart F Page 2, Line 14 31-170

328 DIV: Foreign Dividend Gross-Up Page 2, Line 15 31-175

329 DIV: IC-DISC and Former DISC Page 2, Line 16 31-180

330 DIV: Other Dividends X Page 2, Line 17 31-185

331 DIV: Domestic Corporations Subject to 80% 
Deduction

Page 2, Line 2 31-115

332 DIV: Pref Stock of Less-Than-20%-Owned 
Public Utilities

Page 2, Line 4 31-125

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

2007 TRC
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333 DIV: Pref Stock of 20%-Or-More-Owned Public 
Utilities

Page 2, Line 5 31-130

334 DIV: 20%-Or-More-Owned For Corps/FSCs @ 
80%

Page 2, Line 7 31-140

335 DIV: Domestic Corporations Subject to 70% 
Deduction

Page 2, Line 1 31-110

336 DIV: Less-Than-20%-Owned For Corps/FSCs 
@ 70%

Page 2, Line 6 31-135

337 DIV: Certain FSCs Subject to 100% Deduction Page 2, Line 12 31-160

338 DIV: Domestic Corps Received by SBIC Under 
‘58 Act

Page 2, Line 10 31-150

Page 2: Schedule A, COGS, COPS

400 COPS: Other Costs X Page 2, Line 5 40-250

401 COPS: Depreciation Page 2, Line 5 40-260

402 COGS: Beginning Inventory Page 2, Line 1 40-110

404 COGS: Purchases Page 2, Line 2 40-120

406 COGS: Cost of Labor Page 2, Line 3 40-130

407 COGS: Additional Sec. 263A Costs Page 2, Line 4 40-140

408 COGS: Other Costs X Page 2, Line 5 40-150

410 COGS: Depreciation Page 2, Line 5 40-160

411 COGS: Amortization Page 2, Line 5 40-170

412 COGS: Ending Inventory Page 2, Line 7 40-190

413 COPS: Amortization Page 2, Line 5 40-270

Page 1: Deductions

414 Compensation of Officers Page 1, Line 11 41-210

415 Emploment Credits Page 1, Line 12 41-221

416 Salaries and Wages Page 1, Line 12 41-220

418 Repairs and Maintenance Page 1, Line 14 41-260

420 Bad Debts Page 1, Line 13 41-300

422 Rents Page 1, Line 14 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses X Page 1, Line 15 41-420

426 State and Local Taxes X Page 1, Line 15 41-460

428 Interest X Page 1, Line 16 41-500

430 Current Year Contributions X Page 1, Line 17 41-520

434 Depreciation Page 1, Line 18 41-540

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

2007 TRC
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436 Depletion Page 1, Line 23 41-560

438 Advertising Page 1, Line 19 41-580

439 Meals and Entertainment Page 1, Line 23 41-810

440 Pension, Profit-Sharing, etc. Plans Page 1, Line 20 41-600

441 100% Deductible Travel Page 1, Line 23 41-812

442 Employee Benefit Programs Page 1, Line 21 41-620

443 Amortization Page 1, Line 23 41-820

444 Other Deductions X Page 1, Line 23 41-900

458 Domestic Production Activities Deduction Page 1, Line 22 41-640

Page 5: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 5, Line 2 60-110

602 Excess Capital Loss Over Capital Gain Page 5, Line 3 60-130

603 Foreign Dividend Gross-Up Not on Books Page 5, Line 4 60-142

604 Other Taxable Income Not Recorded on Books X Page 5, Line 4 60-150

615 Tax Over Book Gain Page 5, Line 4 60-144

Page 5: Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 5, Line 5a 60-210

608 Book Over Tax State Taxes Page 5, Line 5c 60-221

610 Book Over Tax Depletion Page 5, Line 5c 60-222

612 Book Over Tax Bad Debts Page 5, Line 5c 60-223

613 Book Over Tax Employment Credit Wage 
Reduction

Page 5, Line 5c 60-226

614 Book Over Tax Amortization Page 5, Line 5c 60-224

616 Book Over Tax Contributions Page 5, Line 5b 60-213

617 Book Over Tax Travel and Entertainment Page 5, Line 5c 60-216

618 Other Book Expenses Not Deducted on Return X Page 5, Line 5c 60-240

620 Tax Exempt Interest Page 5, Line 7 60-410

622 Capital Loss Carryover Utilized Page 5, Line 8b 60-526

624 Other Book Income Not Included on Return X Page 5, Line 7 60-450

635 Book Over Tax Gain Page 5, Line 7 60-544

Page 5, Schedule M-1, Tax Deductions Not Recorded on Books

626  Tax Over Book Depreciation Page 5, Line 8a 60-510

628  Tax Over Book State Taxes Page 5, Line 8b 60-521

630  Tax Over Book Depletion Page 5, Line 8b 60-522

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

2007 TRC
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632  Tax Over Book Bad Debts Page 5, Line 8b 60-523

634  Tax Over Book Amortization Page 5, Line 8b 60-524

636 Contribution Carryover Utilized Page 5, Line 8b 60-613

638 Other Tax Deductions Not Recorded on Books X Page 5, Line 8b 60-540

Page 5: Schedule M-2, Analysis of Unappropriated Retained Earnings

700 Other Increases X Page 5, Line 3 62-300

702 Other Decreases X Page 5, Line 6 62-302

706 Distributions: Property X Page 5, Line 5c 63-306

708 Distributions: Cash Page 5, Line 5a 62-308

710 Distributions: Stock Page 5, Line 5b 62-310

 2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE

2007 TRC
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1120S TAX RETURN CODES
11 2 0 S  TA X  R E T U R N  C O D E S

Form 1120S

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

105 Inventories (Farm) Page 4, Line 3 10-301

106 Inventories Page 4, Line 3 10-300

108 U.S. Government Obligations Page 4, Line 4 10-400

110 Tax Exempt Securities Page 4, Line 5 10-500

112 Other Current Assets X Page 4, Line 6 10-900

114 Loans to Stockholders Page 4, Line 7 11-100

116 Mortgage and Real Estate Loans Page 4, Line 8 11-200

118 Other Investments X Page 4, Line 9 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 10a 11-500

122 Accumulated Depreciation Page 4, Line 10b 11-505

124 Depletable Assets Page 4, Line 11a 11-600

126 Accumulated Depletion Page 4, Line 11b 11-605

128 Land (Net of Amortization) Page 4, Line 12 11-700

130 Intangible Assets: Other Page 4, Line 13a 11-830

132 Accumulated Amortization Page 4, Line 13b 11-835

134 Other Assets X Page 4, Line 14 11-900

Page 4: Schedule L, Liabilities and Capital

200 Accounts Payable Page 4, Line 16 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 17 20-200

204 Other Current Liabilities X Page 4, Line 18 20-300

206 Accrued Federal Income Tax X Page 4, Line 18 20-410

207 Federal Income Tax Deposits Paid X Page 4, Line 18 20-415

208 Accrued State and Local Income Tax X Page 4, Line 18 20-420

209 State and Local Income Tax Deposits Paid X Page 4, Line 18 20-425

210 Loans from Stockholders X Page 4, Line 19 21-100

212 Long-Term Mortgages, Notes and Bonds 
Payable

Page 4, Line 20 21-200
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214 Other Liabilities X Page 4, Line 21 21-300

218 Capital Stock - Common Page 4, Line 22 22-110

220 Additional Paid-In Capital X Page 4, Line 23 22-200

224 Retained Earnings - Unappropriated Page 4, Line 24 22-310

226 Adjustments to Shareholders’ Equity X Page 4, Line 25 22-400

228 Cost of Treasury Stock Page 4, Line 26 22-440

Page 1: Income

300 Gross Receipts or Sales Page 1, Line 1a 30-100

302 Returns and Allowances Page 1, Line 1b 30-105

306 Other Interest X Page 1, Line 5 31-380

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 4 31-660

318 Other Income X Page 1, Line 5 31-900

Page 1: Deductions

414 Compensation of Officers Page 1, Line 7 41-210

415 Employment Credits Page 1, Line 8 41-221

416 Salaries and Wages Page 1, Line 8 41-220

418 Repairs and Maintenance Page 1, Line 9 41-260

420 Bad Debts Page 1, Line 10 41-300

422 Rents Page 1, Line 11 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses X Page 1, Line 12 41-420

426 State and Local Income Tax X Page 1, Line 12 41-460

428 Interest X Page 1, Line 13 41-500

434 Depreciation Page 1, Line 14 41-540

436 Depletion Page 1, Line 15 41-560

438 Advertising Page 1, Line 16 41-580

439 Meals and Entertainment (100%) Page 1, Line 19 41-810

440 Pension, Profit-Sharing, Etc. Plans Page 1, Line 17 41-600

441 100% Deductible Travel Page 1, Line 19 41-812

442 Employee Benefit Programs Page 1, Line 18 41-620

443 Amortization Page 1, Line 19 41-820

444 Other Deductions X Page 1, Line 19 41-900

Page 2: Schedule A, COGS, COPS

400 COPS: Other Costs Page 2, Line 5 40-250

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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401 COPS: Depreciation Page 2, Line 5 40-260

402 COGS: Beginning Inventory Page 2, Line 1 40-110

404 COGS: Purchases Page 2, Line 2 40-120

406 COGS: Cost of Labor Page 2, Line 3 40-130

407 COGS: Additional Sec. 263A Costs X Page 2, Line 4 40-140

408 COGS: Other Costs X Page 2, Line 5 40-150

410 COGS: Depreciation Page 2, Line 5 40-160

411 COGS: Amortization Page 2, Line 5 40-170

412 COGS: Ending Inventory Page 2, Line 7 40-190

413 COPS: Amortization Page 2, Line 5 40-270

Page 3: Schedule K, Other Rental Property, Income

371 OR: Gross Rents Page 2, Line 3a 38-500

373 OR: Other Income Page 2, Line 3a 38-509

Page 3: Schedule K, Other Rental Property, Expenses

471 OR: Advertising Page 3, Line 3b 48-550

473 OR: Auto and Travel Page 3, Line 3b 48-553

475 OR: Cleaning and Maintenance Page 3, Line 3b 48-556

477 OR: Commissions Page 3, Line 3b 48-559

479 OR: Insurance Page 3, Line 3b 48-562

481 OR: Legal and Other Professional Fees Page 3, Line 3b 48-565

483 OR: Interest Page 3, Line 3b 48-568

485 OR: Repairs Page 3, Line 3b 48-571

487 OR: Taxes Page 3, Line 3b 48-574

489 OR: Utilities Page 3, Line 3b 48-577

491 OR: Wages and Salaries Page 3, Line 3b 48-580

493 OR: Other Expenses Page 3, Line 3b 48-599

495 OR: Depreciation Page 3, Line 3b 48-583

497 OR: Amortization Page 3, Line 3b 48-586

Page 3: Schedule K, Income

341 Sch. K: Qualified Dividend Income (Non-
Investment)

Page 2, Line 5b 34-412

354 Sch K: Interest Income on U.S. Obligations Page 2, Line 4 34-300

355 Sch K: Other Interest Income X Page 2, Line 4 34-310

356 Sch K: Other Dividend Income X Page 2, Line 5a 34-419

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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358 Sch K: Royalty Income X Page 2, Line 6 34-470

360 Sch K: Net Short-Term Capital Gain (Loss) Page 2, Line 7 34-500

362 Sch K: Net Long-Term Capital Gain (Loss) Page 2, Line 8 34-550

364 Sch K: Other Portfolio Income (Loss) X Page 2, Line 10 34-710

366 Sch K: Net Gain (Loss) Under Section 1231 Page 2, Line 9 34-600

368 Sch K: Other Income X Page 2, Line 10 34-800

374 Sch K: Casualty Gain (Loss) (Form 4684, Line 
38)

X Page 2, Line 10 34-720

376 Sch K: Section 1256 Gain (Loss) (Form 6781) Page 3, Line 18 34-730

378 Sch K: Section 179 Recapture (Form 4797, Line 
37)

Page 3, Line 17d 34-900

Page 3: Schedule K, Deductions

430 Sch K: Charitable Contributions: Cash (50%) X Page 3, Line 12a 44-400

431 Sch K: Charitable Contributions: Cash (30%) X Page 3, Line 12a 44-410

405 Sch K: Capital Gain Property to a 50% 
Organization (30%)

X Page 3, Line 12a 44-440

432 Sch K: Charitable Contributions: Non-Cash 
(50%)

X Page 3, Line 12a 44-420

437 Sch K: Charitable Contributions: Non-Cash 
(30%)

X Page 3, Line 12a 44-430

417 Sch K: Capital Gain Property (20%) X Page 3, Line 12a 44-450

454 Sch K: Deductions Related to Portfolio Income X Page 3, Line 12d; 
Line 17b

44-530

456 Sch K: Section 179 Expense Deduction X Page 3, Line 11 44-300

462 Sch K: Miscellaneous Deductions X Page 3, Line 12d 44-800

464 Sch K: Interest Expense on Investment Debts Page 3, Line 12b 44-500

466 Sch K: Section 59(e) Expenditures X Page 3, Line 
12c(2)

44-520

468 Sch K: Casualty Loss (Form 4684, Line 32) Page 3, Line 12d 44-540

469 Sch K: Foreign Taxes X Page 3, Line 14I 44-910

Page 4: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 4, Line 3 60-110

604 Other Taxable Income Not Recorded on Books X Page 4, Line 2 60-150

615 Tax Over Book Gain (Loss) on Disposition of 
Assets

Page 4, Line 2 60-144

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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Schedule F

Page 4, Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 4, Line 3a 60-210

608 Book Over Tax State Taxes Page 4, Line 3 60-221

610 Book Over Tax Depletion Page 4, Line 3 60-222

612 Book Over Tax Bad Debts Page 4, Line 3 60-223

614 Book Over Tax Amortization Page 4, Line 3 60-224

616 Nondeductible Expenses Included on 
Schedule K

Page 4, Line 3 60-530

617 Book Over Tax Travel and Entertainment Page 4, Line 3b 60-216

618 Other Book Expenses Not Deducted on Return X Page 4, Line 3 60-240

Page 4, Schedule M-1, Book Not Included on Return

620 Tax-Exempt Interest Page 4, Line 5a 60-410

624 Other Book Income Not Included on Return X Page 4, Line 5 60-450

635 Book Over Tax Gain Page 4, Line 5 60-544

Page 4: Schedule M-1, Tax Deductions Not Recorded on Books

626 Tax Over Book Depreciation Page 4, Line 6a 60-510

628 Tax Over Book State Taxes Page 4, Line 6 60-521

630 Tax Over Book Depletion Page 4, Line 6 60-522

632 Tax Over Book Bad Debts Page 4, Line 6 60-523

634 Tax Over Book Amortization Page 4, Line 6 60-524

638 Other Tax Deductions Not Recorded on Books X Page 4, Line 6 60-540

Page 4: Schedule M-2, 

700 Other Increases X Page 4, Line 3(A) 62-300

702 Other Decreases X Page 4, Line 5(A) 62-302

711 Distributions Other Than Dividend Distributions Page 4, Line 7(A) 62-320

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC

Page 1: Farm Income - Cash Method
307 Farm: Sales of Livestock Bought for Resale 

(Cash)
Line 1 38-100

308 Farm: Cost or Basis of Livestock (Cash) Line 2 48-102
309 Farm: Sales of Livestock Raised (Cash) Line 4 38-104
313 Farm: Cooperative Distributions (Cash) Line 5a & 5b 38-106
317 Farm: Agricultural Program Payments (Cash) Line 6a & 6b 38-108

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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319 Farm: Commodity Credit Corp. Loans 
Reported (Cash)

Line 7a 38-110

323 Farm: Commodity Credit Loans Forfeited 
(Cash)

Line 7b & 7c 38-112

329 Farm: Crop Insurance in Current Year (Cash) Line 8a & 8b 38-114
333 Farm: Crop Insurance Proceeds Deferred 

(Cash)
Line 8d 38-116

337 Farm: Custom Hire (Machine Work) Income 
(Cash)

Line 9 38-118

339 Farm: Other Income (Cash) Line 10 38-120
Page 2: Farm Income - Accrual Method

342 Farm: Sales of Livestock and Other (Accrual) Line 38 38-130
344 Farm: Cooperative Distributions (Accrual) Line 39a & 39b 38-132
346 Farm: Agricultural Program Payments 

(Accrual)
Line 40a & 40b 38-134

347 Farm: Commodity Credit Loans Reported 
(Accrual)

Line 41a 38-136

349 Farm: Commodity Credit Loans Forfeited 
(Accrual)

Line 41b & 41c 38-138

350 Farm: Crop Insurance Proceeds (Accrual) Line 42 38-140
351 Farm: Custom Hire (Machine Work) Income 

(Accrual)
Line 43 38-142

352 Farm: Other Income (Accrual) Line 44 38-150
353 Farm: Beginning Inventory (Accrual) Line 46 48-170
357 Farm: Cost of Livestock Purchased (Accrual) Line 47 48-173
359 Farm: Ending Inventory (Accrual) Line 49 48-176

Page 1: Farm Expenses - Cash and Accrual Method
403 Farm: Car and Truck Expenses Line 12 48-200
409 Farm: Chemicals Line 13 48-203
419 Farm: Conservation Expenses Line 14 48-206
421 Farm: Custom Hire/Machine Work Line 15 48-209
425 Farm: Depreciation Line 16 48-212
427 Farm: Employee Benefits Line 17 48-215
429 Farm: Feed Purchased Line 18 48-218
433 Farm: Fertilizer and Lime Line 19 48-221
445 Farm: Freight and Trucking Line 20 48-224
447 Farm: Gasoline, Fuel, and Oil Line 21 48-227
449 Farm: Insurance Line 22 48-230
450 Farm: Amortization Line 34 48-233
451 Farm: Mortgage Interest Line 23a 48-236
452 Farm: Other Interest Line 23b 48-239
453 Farm: Labor Hired (Net) Line 24 48-242
455 Farm: Pension and Profit Sharing Line 25 48-245

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC
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8825 

457 Farm: Rent or Lease Machinery and 
Equipment

Line 26a 48-248

458 Farm: Rent or Lease Other (Land, Animals, 
etc.)

Line 26b 48-251

459 Farm: Repairs and Maintenance Line 27 48-254
460 Farm: Seeds and Plants Purchased Line 28 48-257
461 Farm: Storage and Warehousing Line 29 48-260
463 Farm: Supplies Purchased Line 30 48-263
465 Farm: Taxes Line 31 48-266
467 Farm: Utilities Line 32 48-269
498 Farm: Veterinary, Breeding, and Medicine Line 33 48-270
499 Farm: Other Expenses Line 34 48-290

2006 MRC D ESCRIPTIO N
DIVISIONAL 

DETAIL 
ROLLUP

FLOWS TO 
PAGE, LINE  2007 

TRC

Rental Real Estate Property: Income
370 RRE: Gross Rents Line 2 38-400

372 RRE: Other Income Line 2 38-409

470 RRE: Advertising Line 3 38-450

472 RRE: Auto and Travel Line 4 38-453

474 RRE: Cleaning and Maintenance Line 5 48-456

476 RRE: Commissions Line 6 48-459

478 RRE: Insurance Line 7 48-462

480 RRE: Legal and Other Professional 
Fees

Line 8 48-465

482 RRE: Interest Line 9 48-468

484 RRE: Repairs Line 10 48-471

486 RRE: Taxes Line 11 48-474

488 RRE: Utilities Line 12 48-477

490 RRE: Wages and Salaries Line 13 48-480

492 RRE: Other Expenses Line 15 48-499

494 RRE: Depreciation Line 14 48-486

496 RRE: Amortization Line 15 48-489

2006 MRC DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC
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1120S TAX RETURN CODES
Schedule M-3
 2006 
MRC

DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC

Part II – Income (Loss) Item
I100 Income (loss) from equity method foreign 

corporations
Page 2, Line 1 I100

I110 Gross foreign dividends not previously taxed Page 2, Line 2 I110
I120 Subpart F, QEF, and similar income inclusions Page 2, Line 3 I120
I140 Gross foreign distributions previously taxed Page 2, Line 4 I140
I150 Income (loss) from equity method US 

corporations
Page 2, Line 5 I150

I160 US dividends not eliminated in tax 
consolidation

Page 2, Line 6 I160

I180 Income (loss) from US partnerships Page 2, Line 7 I180
I190 Income (loss) from foreign partnerships Page 2, Line 8 I190
I200 Income (loss) from other pass-through entities Page 2, Line 9 I200
I210 Items relating to reportable transactions Page 2, Line 10 I210
I220 Interest Income Page 2, Line 11 I220
I230 Total accrual to cash adjustment Page 2, Line 12 I230
I240 Hedging transactions Page 2, Line 13 I240
I250 Mark-to-market income (loss) Page 2, Line 14 I250
I270 Sale versus lease (for sellers and/or lessors) Page 2, Line 16 I270
I280 Section 481(a) adjustments Page 2, Line 17 I280
I290 Unearned / deferred revenue Page 2, Line 18 I290
I300 Income recognition from long-term contracts Page 2, Line 19 I300
I310 Original issue discount and other imputed 

interest
Page 2, Line 20 I310

I320 Income statement gain/loss on sale, 
exchange, abandonment, worthlessness, or 
other disposition of assets other than inventory 
and pass-through entities

Page 2, Line 21a I320

I330 Gross capital gains from Schedule D, 
excluding amount from pass-through entities

Page 2, Line 21b I330

I340 Gross capital losses from Schedule D, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 21c I340

I350 Net gain/loss reported on Form 4797, line 17, 
excluding amounts from pass-through entities, 
abandonment losses, and worthless stock 
losses

Page 2, Line 21d I350

I360 Abandonment losses Page 2, Line 21e I360
I370 Worthless stock losses Page 2, Line 21f I370
I380 Other gain/loss on disposition of assets other 

than inventory
Page 2, Line 21g I380

I410 Other income (loss) items with differences X Page 2, Line 22 I410
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I420 Other items with no differences X Page 2, Line 25 I420
Part III – Expense/Deduction Items

E550 US current income tax expense Page 3, Line 1 E550
E560 US deferred income tax expense Page 3, Line 2 E560
E570 State and local current income tax expense Page 3, Line 3 E570
E580 State and local deferred income tax expense Page 3, Line 4 E580
E590 Foreign current income tax expense (other 

than foreign withholding taxes)
Page 3, Line 5 E590

E600 Foreign deferred income tax expense Page 3, Line 5 E600
E640 Other equity-based compensation Page 3, Line 7 E640
E650 Meals and entertainment Page 3, Line 8 E650
E660 Fines and penalties Page 3, Line 9 E660
E670 Judgments, damages, awards, and similar 

costs
Page 3, Line10 E670

E700 Pension and profit-sharing Page 3, Line 11 E700
E710 Other post-retirement benefits Page 3, Line 12 E710
E720 Deferred compensation Page 3, Line 13 E720
E730 Charitable contribution of cash and tangible 

property
Page 3, Line 14 E730

E740 Charitable contribution of intangible property Page 3, Line 15 E740
E770 Current year acquisition or reorganization 

investment banking fees
Page 3, Line 16 E770

E780 Current year acquisition or reorganization 
legal and accounting fees

Page 3, Line 17 E780

E790 Current year acquisition/reorganization other 
costs

Page 3, Line 18 E790

E800 Amortization / impairment of goodwill Page 3, Line 19 E800
E810 Amortization of acquisition, reorganization, 

and start-up costs
Page 3, Line 20 E810

E820 Other amortization or impairment write-offs Page 3, Line 21 E820
E830 Section 198 environmental remediation costs Page 3, Line 22 E830
E840 Depletion - oil & gas Page 3, Line 23a E840
E841 Depletion - other than oil & gas Page 3, Line 23b E841
E842 Intangible drilling & development costs Page 3, Line 24 E842
E850 Depreciation Page 3, Line 25 E850
E860 Bad debt expense Page 3, Line 26 E860
E621 Interest expense Page 3, Line 27 E621
E880 Purchase versus lease (for purchasers and/or 

lessees)
Page 3, Line 28 E880

E890 Other expense/deduction items with 
differences (attach schedule)Page 3, Line 15

X Page 3, Line 29 E890

 2006 
MRC

DESCRIPTION CROSS
-TIE

FLOWS TO 
PAGE, LINE

 2007 
MRC
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8916-A Return Codes 

 2006 MRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 MRC

I260.01 Amounts attributable to cost flow assumptions 1 I260.01
I260.02A Stock option expense 2a I260.02A
I260.02B Other equity based compensation 2b I260.02B
I260.02C Meals and entertainment 2c I260.02C
I260.02D Parachute payments 2d I260.02D
I260.02E Compensation with section 162(m) limitation 2e I260.02E
I260.02F Pension and profit sharing 2f I260.02F
I260.02G Other post-retirement benefits 2g I260.02G
I260.02H Deferred compensation 2h I260.02H
I260.02I Section 198 environmental remediation costs 2i I260.02I
I260.02J Amortization 2j I260.02J
I260.02K Depletion 2k I260.02K
I260.02L Depreciation 2l I260.02L
I260.02M Corporate owned life insurance premiums 2m I260.02M
I260.02N Other section 263A costs 2n I260.02N
I260.03 Inventory shrinkage accruals 3 I260.03
I260.04 Excess inventory and obsolescence reserves 4 I260.04
I260.05 Lower of cost or market write-downs 5 I260.05
I260.06 Other items with differences (attach schedule) 6 I260.06
I260.07 Other items with no differences 7 I260.07
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1120-REIT TAX RETURN CODES
11 2 0 - R E I T  TA X  R E T U R N  C O D E S

Form 1120-REIT

 2006 TRC DESCRIPTION FLOWS TO 
PAGE, LINE 2007 TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

108 U.S. Government Obligations Page 4, Line 3 10-400

110 Tax Exempt Securities Page 4, Line 4 10-500

112 Other Current Assets Page 4, Line 5 10-900

114 Loans to Stockholders Page 4, Line 6 11-100

116 Mortgage and Real Estate Loans Page 4, Line 7 11-200

118 Other Investments Page 4, Line 8 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 9a 11-500

122 Accumulated Depreciation Page 4, Line 9b 11-505

128 Land (Net of Amortization) Page 4, Line 10 11-700

130 Intangible Assets: Other Page 4, Line 11A 11-830

132 Accumulated Amortization Page 4, Line 11B 11-835

134 Other Assets Page 4, Line 12 11-900

Page 4: Schedule L, Liabilities & Equity

200 Accounts Payable Page 4, Line 14 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 15 20-200

204 Other Current Liabilities Page 4, Line 16 20-300

206 Accrued Federal Income Tax Page 4, Line 16 20-410

207 Federal Income Tax Deposits Paid Page 4, Line 16 20-415

208 Accrued State and Local Income Tax Page 4, Line 16 20-420

209 State and Local Income Tax Deposits Paid Page 4, Line 16 20-425

210 Loans from Stockholders Page 4, Line 17 21-100

212 Long-Term Mortgages, Notes, and Bonds 
Payable

Page 4, Line 18 21-200

214 Other Liabilities Page 4, Line 19 21-300

216 Capital Stock - Preferred Page 4, Line 20a 22-100

218 Capital Stock - Common Page 4, Line 20b 22-110

220 Additional Paid-In Capital Page 4, Line 21 22-200
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222 Retained Earnings - Appropriated Page 4, Line 22 22-300

224 Retained Earnings - Unappropriated Page 4, Line 23 22-310

226 Adjustments to Shareholders’ Equity Page 4, Line 24 22-400

228 Cost of Treasury Stock Page 4, Line 25 22-440

Page 1: Income

303 Dividend Income Page 1, Line 1 30-108

304 Interest on U.S. Obligations Page 1, Line 2 30-340

306 Other Interest Page 1, Line 2 31-380

312 Net Farm Profit (Loss) Page 1, Line 7 31-662

314 Capital Gains (Schedule D) Page 1, Line 5 31-620

316 Net Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 6 31-660

318 Other Income Page 1, Line 7 31-900

Page 1: Rental Real Estate Property, Income

370 RRE: Gross Rents Page 1, Line 3 38-400

372 RRE: Other Income Page 1, Line 7 38-409

Page 1: Other Rental Property, Income

334 OR: Gross Rents Page 1, Line 4 38-500

336 OR: Other Income Page 1, Line 7 38-509

Page 1: Other Rental Property, Expenses

450 OR: Advertising Page 1, Line 17 48-550

451 OR: Auto and Travel Page 1, Line 18 48-553

452 OR: Cleaning and Maintenance Page 1, Line 18 48-556

453 OR: Commissions Page 1, Line 18 48-559

454 OR: Insurance Page 1, Line 18 48-562

455 OR: Legal and Other Professional Fees Page 1, Line 18 48-565

456 OR: Interest Page 1, Line 15 48-568

457 OR: Repairs Page 1, Line 11 48-571

458 OR: Taxes Page 1, Line 14 48-574

459 OR: Utilities Page 1, Line 18 48-577

460 OR: Wages and Salaries Page 1, Line 10 48-580

461 OR: Other Expenses Page 1, Line 18 48-599

462 OR: Depreciation Page 1, Line 16 48-583

463 OR: Amortization Page 1, Line 18 48-586
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1120-REIT TAX RETURN CODES
Page 1: Deductions

414 Compensation of Officers Page 1, Line 9 41-210

415 Emploment Credits Page 1, Line 10 41-221

416 Salaries and Wages Page 1, Line 10 41-220

418 Repairs and Maintenance Page 1, Line 11 41-260

420 Bad Debts Page 1, Line 12 41-300

422 Rents Page 1, Line 13 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses Page 1, Line 14 41-420

426 State and Local Taxes Page 1, Line 14 41-460

428 Interest Page 1, Line 15 41-500

434 Depreciation Page 1, Line 16 41-540

438 Advertising Page 1, Line 17 41-580

439 Meals and Entertainment Page 1, Line 18 41-810

441 100% Deductible Travel Page 1, Line 18 41-812

443 Amortization Page 1, Line 18 41-820

444 Other Deductions Page 1, Line 18 41-900

Page 1: Rental Real Estate Property, Expense

470 RRE: Advertising Page 1, Line 17 48-450

471 RRE: Auto and Travel Page 1, Line 18 48-453

472 RRE: Cleaning and Maintenance Page 1, Line 18 48-456

473 RRE: Commissions Page 1, Line 18 48-459

474 RRE: Insurance Page 1, Line 18 48-462

475 RRE: Legal and Other Professional Fees Page 1, Line 18 48-465

476 RRE: Interest Page 1, Line 15 48-468

477 RRE: Repairs Page 1, Line 11 48-471

478 RRE: Taxes Page 1, Line 14 48-474

479 RRE: Utilities Page 1, Line 18 48-477

480 RRE: Wages and Salaries Page 1, Line 10 48-480

482 RRE: Other Expenses Page 1, Line 18 48-499

484 RRE: Depreciation Page 1, Line 16 48-486

486 RRE: Amortization Page 1, Line 18 48-489

Page 4: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 4, Line 2a 60-110
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602 Excess Capital Loss Over Capital Gain Page 4, Line 3 60-130

603 Foreign Dividend Gross-Up Not on Books Page 4, Line 4 60-142

604 Other Taxable Income Not Recorded on Books Page 4, Line 4 60-150

615 Tax Over Book Gain Page 4, Line 4 60-144

Page 4: Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 4, Line 5a 60-210

608 Section 4981 Tax Page 4, Line 5b 60-231

612 Book Over Tax Bad Debts Page 4, Line 5c 60-223

613 Book Over Tax Employment Credit Wage 
Reduction

Page 4, Line 5c 60-226

614 Book Over Tax Amortization Page 4, Line 5c 60-224

617 Book Over Tax Travel and Entertainment Page 4, Line 5c 60-216

618 Other Book Expenses Not Deducted on Return Page 4, Line 5c 60-240

619 Book Over Tax State Taxes Page 4, Line 5c 60-221

620 Tax Exempt Interest Page 4, Line 7 60-410

622 Passive Loss Carryover Utilized Page 4, Line 7 60-527

624 Other Book Income Not Included on Return Page 4, Line 7 60-450

635 Book Over Tax Gain Page 4, Line 7 60-544

Page 4, Schedule M-1, Tax Deductions Not Recorded on Books

626 Tax Over Book Depreciation Page 4, Line 8a 60-510

628 Tax Over Book State Taxes Page 4, Line 8c 60-521

629 Capital Loss Carryover Utilized Page 4, Line 8c 60-526

632 Tax Over Book Bad Debts Page 4, Line 8c 60-523

634 Tax Over Book Amortization Page 4, Line 8c 60-524

638 Other Tax Deductions Not Recorded on Books Page 4, Line 8c 60-540

Page 4: Schedule M-2, Analysis of Unappropriated Retained Earnings

700 Other Increases Page 4, Line 3 62-300

702 Other Decreases Page 4, Line 6 62-302

706 Distributions: Property Page 4, Line 5c 63-306

708 Distributions: Cash Page 4, Line 5a 62-308

710 Distributions: Stock Page 4, Line 5b 62-310
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1120-RIC TAX RETURN CODES
11 2 0 - R I C  TA X  R E T U R N  C O D E S

Form 1120-RIC

2006 TRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

108 U.S. Government Obligations Page 4, Line 3 10-400

110 Tax Exempt Securities Page 4, Line 4 10-500

112 Other Current Assets Page 4, Line 5 10-900

114 Loans to Stockholders Page 4, Line 6 11-100

116 Mortgage and Real Estate Loans Page 4, Line 7 11-200

118 Other Investments Page 4, Line 8 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 9a 11-500

122 Accumulated Depreciation Page 4, Line 9b 11-505

128 Land (Net of Amortization) Page 4, Line 10 11-700

130 Intangible Assets: Other Page 4, Line 11a 11-830

132 Accumulated Amortization Page 4, Line 11b 11-835

134 Other Assets Page 4, Line 12 11-900

Page 4: Schedule L, Liabilities & Equity

200 Accounts Payable Page 4, Line 14 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 15 20-200

204 Other Current Liabilities Page 4, Line 16 20-300

206 Accrued Federal Income Tax Page 4, Line 16 20-410

207 Federal Income Tax Deposits Paid Page 4, Line 16 20-415

208 Accrued State and Local Income Tax Page 4, Line 16 20-420

209 State and Local Income Tax Deposits Paid Page 4, Line 16 20-425

210 Loans from Stockholders Page 4, Line 17 21-100

212 Long-Term Mortgages, Notes, and Bonds 
Payable

Page 4, Line 18 21-200

214 Other Liabilities Page 4, Line 19 21-300

218 Capital Stock - Common Page 4, Line 20 22-110

220 Additional Paid-In Capital Page 4, Line 21 22-200

222 Retained Earnings - Appropriated Page 4, Line 22 22-300
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224 Retained Earnings - Unappropriated Page 4, Line 23 22-310

226 Adjustments to Shareholders’ Equity Page 4, Line 24 22-400

228 Cost of Treasury Stock Page 4, Line 25 22-440

Page 1: Income

303 Dividend Income Page 1, Line 1 30-108

304 Interest on U.S. Obligations Page 1, Line 2 30-340

306 Other Interest Page 1, Line 2 31-380

307 Net Foreign Currency Gain (Loss) (Sec. 988) Page 1, Line 3 31-383

308 Gross Rents Page 1, Line 7 31-420

309 Payments with Respect to Securities Loans Page 1, Line 4 31-424

312 Net Farm Profit (Loss) Page 1, Line 7 31-662

314 Capital Gains (Schedule D) Page 1, Line 5 31-620

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 6 31-660

318 Other Income Page 1, Line 7 31-900

Page 1: Deductions

414 Compensation of Officers Page 1, Line 9 41-210

415 Emploment Credits Page 1, Line 10 41-221

416 Salaries and Wages Page 1, Line 10 41-220

422 Rents Page 1, Line 11 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses Page 1, Line 12 41-420

426 State and Local Taxes Page 1, Line 12 41-460

428 Interest Page 1, Line 13 41-500

434 Depreciation Page 1, Line 14 41-540

438 Advertising Page 1, Line 15 41-580

429 Registration Fees Page 1, Line 16 41-510

430 Insurance Page 1, Line 17 41-530

439 Meals and Entertainment Page 1, Line 22 41-810

441 100% Deductible Travel Page 1, Line 22 41-812

443 Amortization Page 1, Line 22 41-820

444 Other Deductions Page 1, Line 22 41-900

446 Accounting and Legal Services Page 1, Line 18 41-630

448 Management and Investment Advisory Fees Page 1, Line 19 41-631

2006 TRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 TRC
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450 Transfer Agency, Shareholder Servicing, Etc. 
Fees

Page 1, Line 20 41-632

452 Reports to Shareholders Page 1, Line 21 41-633

454 Dividends Paid Deduction Page 1, Line 25 41-634

Page 4: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 4, Line 2 60-110

602 Excess Capital Loss Over Capital Gain Page 4, Line 3 60-130

603 Foreign Dividend Gross-Up Not on Books Page 4, Line 4 60-142

604 Other Taxable Income Not Recorded on Books Page 4, Line 4 60-150

615 Tax Over Book Gain Page 4, Line 4 60-144

Page 4: Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 4, Line 5a 60-210

607 Expenses Allocable to Tax-Exempt Interest 
Income

Page 4, Line 5b 60-212

608 Book Over Tax State Taxes Page 4, Line 5d 60-221

611 Section 4982 Tax Page 4, Line 5c 60-215

612 Book Over Tax Bad Debts Page 4, Line 5d 60-223

613 Book Over Tax Employment Credit Wage 
Reduction

Page 4, Line 5d 60-226

614 Book Over Tax Amortization Page 4, Line 5d 60-224

617 Book Over Tax Travel and Entertainment Page 4, Line 5d 60-216

618 Other Book Expenses Not Deducted on Return Page 4, Line 5d 60-240

Schedule M-1: Book Income Not Included on Return

620 Tax-Exempt Interest Page 4, Line 7 60-410

622 Capital Loss Carryover Utilized Page 4, Line 8b 60-526

624 Other Book Income Not Included on Return Page 4, Line 7 60-450

635 Book Over Tax Gain Page 4, Line 7 60-544

Page 4, Schedule M-1, Tax Deductions Not Recorded on Books

626 Tax Over Book Depreciation Page 4, Line 8a 60-510

628 Tax Over Book State Taxes Page 4, Line 8b 60-521

632 Tax Over Book Bad Debts Page 4, Line 8b 60-523

634 Tax Over Book Amortization Page 4, Line 8b 60-524

638 Other Tax Deductions Not Recorded on Books Page 4, Line 8b 60-540

640 Net Capital Gain (Form 2438, Line 9a) Page 4, Line 9 60-532
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PAGE, LINE  2007 TRC
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1120-RIC TAX RETURN CODES
642 Dividends Paid Deduction Page 4, Line 8b 60-528

Page 4: Schedule M-2, Analysis of Unappropriated Retained Earnings

700 Other Increases Page 4, Line 3 62-300

702 Other Decreases Page 4, Line 6 62-302

706 Distributions: Property Page 4, Line 5c 63-306

708 Distributions: Cash Page 4, Line 5a 62-308

710 Distributions: Stock Page 4, Line 5b 62-310

2006 TRC DESCRIPTION FLOWS TO 
PAGE, LINE  2007 TRC
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1120-F TAX RETURN CODES
11 2 0 - F  TA X  R E T U R N  C O D E S

Form 1120-FNote:

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC

Page 4: Schedule L, Assets 

100 Cash Page 4, Line 1 10-100

102 Trade Notes and Accounts Receivable Page 4, Line 2a 10-200

104 Allowance for Bad Debts Page 4, Line 2b 10-205

106 Inventories Page 4, Line 3 10-300

108 U.S. Government Obligations X Page 4, Line 4 10-400

110 Tax Exempt Securities X Page 4, Line 5 10-500

112 Other Current Assets X Page 4, Line 6 10-900

114 Loans to Stockholders Page 4, Line 7 11-100

116 Mortgage and Real Estate Loans X Page 4, Line 8 11-200

118 Other Investments X Page 4, Line 9 11-400

120 Buildings and Other Depreciable Assets Page 4, Line 10a 11-500

122 Accumulated Depreciation Page 4, Line 10b 11-505

124 Depletable Assets Page 4, Line 11a 11-600

126 Accumulated Depletion Page 4, Line 11b 11-605

128 Land (Net of Amortization) Page 4, Line 12 11-700

130 Intangible Assets: Other Page 4, Line 13a 11-830

132 Accumulated Amortization Page 4, Line 13b 11-835

134 Other Assets X Page 4, Line 14 11-900

Page 4: Schedule L, Liabilities & Equity

200 Accounts Payable Page 4, Line 16 20-100

202 Current Mortgages, Notes, and Bonds Payable Page 4, Line 17 20-200

204 Other Current Liabilities X Page 4, Line 18 20-300

206 Accrued Federal Income Tax X Page 4, Line 18 20-410

207 Federal Income Tax Deposits Paid X Page 4, Line 18 20-415

208 Accrued State and Local Income Tax X Page 4, Line 18 20-420

209 State and Local Income Tax Deposits Paid X Page 4, Line 18 20-425

210 Loans from Stockholders X Page 4, Line 19 21-100

212 Long-Term Mortgages, Notes, and Bonds 
Payable

Page 4, Line 20 21-200
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214 Other Liabilities X Page 4, Line 21 21-300

216 Capital Stock - Preferred Page 4, Line 22a 22-100

218 Capital Stock - Common Page 4, Line 22b 22-110

220 Additional Paid-In Capital X Page 4, Line 23 22-200

222 Retained Earnings - Appropriated X Page 4, Line 24 22-300

224 Retained Earnings - Unappropriated Page 4, Line 25 22-310

226 Adjustments to Shareholders’ Equity X Page 4, Line 26 22-400

228 Cost of Treasury Stock Page 4, Line 27 22-440

Page 1: Income

300 Gross Receipts or Sales Page 1, Line 1a 30-100

302 Returns and Allowances Page 1, Line 1b 30-105

304 Interest on U.S. Obligations Page 1, Line 5 31-340

306 Other Interest X Page 1, Line 5 31-380

308 Gross Rents Page 1, Line 6 31-420

310 Gross Royalties Page 1, Line 7 31-520

312 Net Farm Profit (Loss) Page 1, Line 10 31-662

314 Capital Gains (Schedule D) Page 1, Line 8 31-620

316 Ordinary Gain (Loss) (Form 4797, Part II) Page 1, Line 9 31-660

318 Other Income X Page 1, Line 10 31-900

Page 2: Schedule C, Dividends and Special Deductions

321 DIV: Debt-Financed Stock of Domestic/Foreign 
Corps

Page 2, Line 3 31-120

326 DIV: Other Foreign Corporations Page 2, Line 13 31-165

328 DIV: Foreign Dividend Gross-Up Page 2, Line 15 31-175

329 DIV: IC-DISC and Former DISC Page 2, Line 16 31-180

330 DIV: Other Dividends X Page 2, Line 17 31-185

331 DIV: Domestic Corporations Subject to 80% 
Deduction

Page 2, Line 2 31-115

332 DIV: Pref Stock of Less-Than-20%-Owned 
Public Utilities

Page 2, Line 4 31-125

333 DIV: Pref Stock of 20%-Or-More-Owned Public 
Utilities

Page 2, Line 5 31-130

334 DIV: 20%-Or-More-Owned For Corps/FSCs @ 
80%

Page 2, Line 7 31-140

335 DIV: Domestic Corporations Subject to 70% 
Deduction

Page 2, Line 1 31-110

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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336 DIV: Less-Than-20%-Owned For Corps/FSCs 
@ 70%

Page 2, Line 6 31-135

Page 2: Schedule A, COGS, COPS

400 COPS: Other Costs X Page 2, Line 5 40-250

401 COPS: Depreciation Page 2, Line 5 40-260

402 COGS: Beginning Inventory Page 2, Line 1 40-110

404 COGS: Purchases Page 2, Line 2 40-120

406 COGS: Cost of Labor Page 2, Line 3 40-130

407 COGS: Additional Sec. 263A Costs Page 2, Line 4 40-140

408 COGS: Other Costs X Page 2, Line 5 40-150

410 COGS: Depreciation Page 2, Line 5 40-160

411 COGS: Amortization Page 2, Line 5 40-170

412 COGS: Ending Inventory Page 2, Line 7 40-190

413 COPS: Amortization Page 2, Line 5 40-270

Page 1: Deductions

414 Compensation of Officers Page 1, Line 12 41-210

415 Emploment Credits Page 1, Line 13 41-221

416 Salaries and Wages Page 1, Line 13 41-220

418 Repairs and Maintenance Page 1, Line 14 41-260

420 Bad Debts Page 1, Line 15 41-300

422 Rents Page 1, Line 16 41-350

423 Federal Income Tax Provision Per Book N/A 41-400

424 Taxes and Licenses X Page 1, Line 17 41-420

426 State and Local Taxes X Page 1, Line 17 41-460

428 Interest X Page 1, Line 18 41-500

430 Current Year Contributions X Page 1, Line 19 41-520

434 Depreciation Page 1, Line 20 41-540

436 Depletion Page 1, Line 21 41-560

438 Advertising Page 1, Line 22 41-580

439 Meals and Entertainment Page 1, Line 26 41-810

440 Pension, Profit-Sharing, etc. Plans Page 1, Line 23 41-600

441 100% Deductible Travel Page 1, Line 26 41-812

442 Employee Benefit Programs Page 1, Line 24 41-620

443 Amortization Page 1, Line 26 41-820

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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1120-F TAX RETURN CODES
444 Other Deductions X Page 1, Line 26 41-900

Page 4: Schedule M-1, Taxable Income Not Recorded on Books

600 Federal Income Tax Page 4, Line 2 60-110

602 Excess Capital Loss Over Capital Gain Page 4, Line 3 60-130

603 Foreign Dividend Gross-Up Not on Books Page 4, Line 4 60-142

604 Other Taxable Income Not Recorded on Books X Page 4, Line 4 60-150

615 Tax Over Book Gain Page 4, Line 4 60-144

Page 4: Schedule M-1, Book Expenses Not Deducted on Return

606 Book Over Tax Depreciation Page 4, Line 5a 60-210

608 Book Over Tax State Taxes Page 4, Line 5c 60-221

610 Book Over Tax Depletion Page 4, Line 5c 60-222

612 Book Over Tax Bad Debts Page 4, Line 5c 60-223

613 Book Over Tax Employment Credit Wage 
Reduction

Page 4, Line 5c 60-226

614 Book Over Tax Amortization Page 4, Line 5c 60-224

616 Book Over Tax Contributions Page 4, Line 5b 60-213

617 Book Over Tax Travel and Entertainment Page 4, Line 5c 60-216

618 Other Book Expenses Not Deducted on Return X Page 4, Line 5c 60-240

Page 4, Schedule M-1, Book Income Not Included on Return

620 Tax Exempt Interest Page 4, Line 7 60-410

624 Other Book Income Not Included on Return X Page 4, Line 7 60-450

635 Book Over Tax Gain Page 4, Line 7 60-544

Page 4, Schedule M-1, Tax Deductions Not Recorded on Books

622 Capital Loss Carryover Utilized Page 4, Line 8b 60-526

Page 4, Schedule L, Assests

626  Tax Over Book Depreciation Page 4, Line 8a 60-510

628  Tax Over Book State Taxes Page 4, Line 8b 60-521

630  Tax Over Book Depletion Page 4, Line 8b 60-522

632  Tax Over Book Bad Debts Page 4, Line 8b 60-523

634  Tax Over Book Amortization Page 4, Line 8b 60-524

636 Contribution Carryover Utilized Page 4, Line 8b 60-613

638 Other Tax Deductions Not Recorded on Books X Page 4, Line 8b 60-540

Page 4: Schedule M-2, Analysis of Unappropriated Retained Earnings

700 Other Increases X Page 4, Line 3 62-300

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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1120-F TAX RETURN CODES
Note: Forms with updated TRCs will be available after the IRS finalizes all 
forms shown in this guide.

702 Other Decreases X Page 4, Line 6 62-302

706 Distributions: Property X Page 4, Line 5c 63-306

708 Distributions: Cash Page 4, Line 5a 62-308

710 Distributions: Stock Page 4, Line 5b 62-310

2006 TRC DESCRIPTION CROSS-
TIE

FLOWS TO 
PAGE, LINE 2007 TRC
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	To import a package or template
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	8. Select OK. The import process is complete.
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	Suppressing merge of prior year balances:
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	3. If the descriptions in the import file match exactly with the descriptions in the tax application, then the prior year balanc...

	Note:
	To initiate a merge
	1. Select Options | Merge Now.
	2. Trial Balance Bridge merges the data in the Trial Balance Bridge file into the tax application file as follows:
	3. When you select Merge Now, all tax forms are updated as long as they have been selected on Options | Merge Defaults.
	4. To update specific forms, you must specify the forms you want to merge through Options | Merge Defaults. Only the forms that you select are updated with new data.


	Merging Data into an Existing Locator
	Or
	Tip:

	Cross-Ties
	Generating Cross-Ties for Consolidated Returns
	1. On the Options menu, click Merge Defaults.
	2. To create cross-ties for consolidated returns, select the Create Cross-Tie (Consolidated Return) check box.

	TRCs without TCCs
	MRCs without MCCs
	Note:
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	Exporting Trial Balance Data
	Trial Balance Export
	Journal Entries Export
	TCC Export
	MCC Export
	Exporting Company Details
	Exporting Data
	1. On the File menu, click Export. The Export dialog box appears.
	2. Select one of the following export items: Trial Balance, Journal Entry, TCC Descriptions, MCC Descriptions, Company Detail, or Workpapers.
	3. Select the file format for the exported file: DIF, ASCII, Excel, or Access.
	4. Select the output file name including the drive and path or accept the default.
	5. Click Export to start the process.
	6. If errors occur during the export process, click Errors to review.

	Workpaper Export
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	Making Journal Entries in Trial Balance Bridge
	Notes:
	Journal Entry Basics
	Entering Detail for a Journal Entry
	1. The system automatically assigns the journal entry number.
	2. Enter a brief description of the entry.
	3. Enter the journal entry detail in the Journal Entry Grid.
	4. For unbalanced entries, the Differences box shows the differences between total debits and total credits.
	5. The Journal Memo text area allows you to enter any explanatory information about the journal entry. For example, you may want to add a special note for reviewers. Since journal entries are proformaed, you can leave a memo to next year's preparers.
	6. Use the Prior and Next buttons to move from one entry to another.
	7. Select Done to exit the screen and save changes.
	8. Use the Accounts button if you are unsure of which account number you want to use. Click this button to display the list of a...
	9. Use the TRCs button for creating temporary accounts using the TAXnn-nnn feature. Click this button to display the list of TRC...
	10. Select the List TAXnn-nnn Accounts? check box to include existing TAXnn-nnn accounts in the list of TRCs that appear.
	11. Use the TCC Lookup button to view a list of TRCs and corresponding TCCs.


	Adding a Journal Entry Line
	1. On the grid on the Journal Entry Detail dialog box, go to the first available cell under Account and add your information for that line.
	2. To insert a line, highlight the line below where you want your new line to appear and click Insert.

	Entering an Account Description
	1. If you enter a valid account on the Journal Entry Detail dialog box, the description automatically appears.
	2. If you enter an invalid account, an invalid account message appears in the description column and this row of the entry is not saved when you exit the Journal Entry Detail dialog box.

	Entering Debits and Credits
	1. When you enter debits and credits on the Journal Entry Detail dialog box, the software recognizes a number in the debit column as a positive number, and a number in the Credit column as a negative number.
	2. Whenever you type a number in the Credit column, the number changes to red and is considered a credit or a negative number. The number you type in the debit column remains black and is considered a debit or a positive number.

	Deleting a Journal Entry Line
	1. On the grid on the Journal Entry Detail dialog box, highlight the line you want to delete.
	2. Click Delete.

	Importing Journal Entries
	1. To import a source file, either type the drive/path and file name in the Drive/path and file name: field, or click Browse and choose the file you want to import from the Open dialog box.
	2. The Import Items area on the screen allows you to select the items you want to import. The Account Number, Journal Entry Desc...
	3. To perform an import, click the Import button.
	4. If import errors are present, the Errors button activates. To review the errors, click the Errors button.
	5. When you are finished importing, click Done.

	Using Automatic Journal Entries
	1. On the Options menu, click Automatic Journal Entries.
	2. Select the appropriate check box(es) to use automatic journal entries for:
	3. For COGS, if selected, enter the TRC to which to assign the difference.
	4. Click OK to save and close the dialog box.
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	Understanding the TAXnn-nnn Feature
	Journal Entries
	TAXnn-nnn and M-1 or M-3 Schedule
	Generating a Detail Statement
	Automatic Journal Entries
	Cost of Goods Sold
	Acct Number
	Description
	Debit
	Credit

	Amounts Available for PYB and Preliminary CYB for Beginning Inventory
	Adjustment for Schedule F: Farm
	Acct Number
	Description
	Debit
	Credit

	Guaranteed Payments
	Acct Number
	Description
	Debit
	Credit

	Federal Income Tax Provision
	Acct Number
	Description
	Debit
	Credit

	Meals and Entertainment
	1065
	Acct Number
	Description
	Debit
	Credit
	1120

	Acct Number
	Description
	Debit
	Credit
	1120-C

	Acct Number
	Description
	Debit
	Credit
	1120F

	Acct Number
	Description
	Debit
	Credit
	1120S

	Acct Number
	Description
	Debit
	Credit
	1120-REIT

	Acct Number
	Description
	Debit
	Credit
	1120-RIC

	Acct Number
	Description
	Debit
	Credit
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	Terms and Definitions
	Term
	Definition
	Changing the Trial Balance Grid
	Sizing Columns and Rows
	1. Place the mouse pointer on the column or row label cell until the pointer becomes a crosshair (you must be in the cell label area of the Grid to change size).
	2. Hold down the left mouse button and drag the row or column to the size you want. When you change a row size, all rows in the ...

	Moving Columns
	1. Highlight the column you want to move by clicking on the label cell of the column.
	2. Press Shift while holding down the left mouse button. The mouse pointer appears with a small rectangular outline.
	3. Drag the column to where you want it and release the mouse button. The column appears in the new location on the Grid. You ca...

	Inserting New Rows
	1. Decide where you want the new row on the Grid. New rows are added above an existing row.
	2. Highlight the row that will come after the new row by clicking on the row label.
	3. On the Edit menu, click Insert or press Insert. The new row appears above the highlighted row.

	Deleting Rows
	1. Highlight the row you want to delete by clicking the mouse pointer on the row label for that row. To select multiple rows, hold down the Shift key and click the rows you want to select.
	2. On the Edit menu, click Delete or press Delete.
	3. A delete confirmation message appears. Click OK or press Enter. All the selected rows are deleted.

	Going to a Specific Account on the Grid
	1. On the Edit menu, click GoTo Account. The GoTo Account dialog box appears.
	2. Type the account number you want in the Number field.
	3. Click OK. The Grid scrolls to the designated account, highlights it, and displays it at the top of the Grid view.

	Finding an Account by its Description
	1. On the Edit menu, click Find Account Description. The Find Account Description dialog box appears.
	2. Type any consecutive characters of an account description. (Find is not case- sensitive.)
	3. Click Find. The Grid scrolls to the account containing the specified characters.
	4. If you want to continue searching for the specified characters, select Find Next.

	Sorting the Trial Balance Grid
	1. On the Edit menu, click Sort Trial Balance. The Sort dialog box appears.
	2. Select the sort option you want.
	3. Select OK. A progress dialog box displays. When sorting is complete, the resorted Trial Balance Grid appears.
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	Tax Return Codes (TRCs)
	Assigning or Changing a Tax Return Code (TRC)
	1. Go to the Trial Balance Grid screen.
	2. Select the appropriate TRC in the drop-down list.
	3. Select the appropriate cell(s) or row(s) of the account(s) to which you want to assign or change the TRC. To select multiple rows, hold down the left mouse button while you drag over the rows you want to select.
	4. Select Assign Coding. The new TRC appears on the Trial Balance Grid for the account you selected. (You can also type the TRC on the Grid by placing the cursor in the TRC cell and typing in the code then pressing Enter.)

	M-3 Return Codes (MRCs)
	Assigning or Changing an M-3 Return Code (MRC)
	1. Go to the Trial Balance Grid screen.
	2. Select the appropriate row of the account to which you want to assign or change the MRC
	3. Select the appropriate TRC from the drop-down list.
	4. Select the appropriate MRC from the MRC drop-down list.
	5. Select Assign Coding. The new MRC appears on the Trial Balance Grid for the account you selected. You can assign a TRC code a...


	Tax Combination Codes (TCCs)
	Creating a Tax Combination Code
	1. Go to the Trial Balance Grid screen.
	2. Select the appropriate TRC in the drop-down list.
	3. Click the drop-down list for TCC and select Add New. The New Item dialog box appears.
	4. Type the TCC code and description in the New Code and Description fields. You can also type the TCC in the appropriate cell. ...
	5. Click OK. The new TCC appears in the TCC drop-down list.

	Assigning a Tax Combination Code
	1. Go to the Trial Balance Grid.
	2. Since TCCs relate to TRCs, scroll through the TRC drop-down list and locate the TRC of the account to which you want to assign a TCC and select the appropriate TRC.
	3. Select the TCC drop-down box. If a TCC has been assigned to a particular TRC and account, it appears with its description in the TCC drop-down list.
	4. Click the TCC.
	5. Select the appropriate cell(s) or row(s) of the account(s) to which you want to assign TCCs. To assign TCCs to multiple rows, hold down the left mouse button while you drag over the rows you want to select.
	6. Select Assign Coding. The TCC displays in the TCC column (if you know which TCC to assign, you can type the TCC in the appropriate cell on the Trial Balance Grid).

	Changing a Tax Combination Code Description
	1. Go to the Trial Balance Grid screen.
	2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog box appears.
	3. Select Tax Combination Code Description to display TCCs and their corresponding descriptions.
	4. Click the TCC description field.
	5. Type the description change.
	6. Press Done when all necessary descriptions have been changed.

	Deleting a Tax Combination Code
	1. On the Edit menu, click TCC/PC/MCC Descriptions from the Trial Balance Grid screen.
	2. Highlight the row(s) containing the TCC(s) you want to delete.
	3. Press Delete.
	4. This function deletes the TCC and TCC description and removes this information from all accounts on the Trial Balance Grid associated with that TRC and TCC.


	Property Codes (PCs)
	Note:
	Assigning a Property Code
	1. Go to the Trial Balance Grid.
	2. Determine the accounts and the TRC of the accounts to which you want to assign Property Codes.
	3. Select the appropriate TRC in the drop-down list.
	4. Select the drop-down list for PC and select the Property Code to assign.
	5. Select the appropriate cell(s) or row(s) of the accounts to which you want to assign Property Codes.
	6. Select Assign Coding or type the code in the appropriate cell.

	Changing a Property Code Description
	1. Go to the Trial Balance Grid screen.
	2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog box appears.
	3. Select Property Code Description to display Property Codes and their corresponding descriptions.
	4. Click the PC description field.
	5. Type the description change.
	6. Click Done when all necessary descriptions have been changed.

	Creating a Property Code
	1. Go to the Trial Balance Grid screen.
	2. Select the appropriate TRC in the drop-down list.
	3. Click the PC drop-down list, and then select Add New. The New Item dialog box appears. Note: PCs can only be added to TRCs that require PCs.
	4. Enter the PC code and description in the New Code and Description fields. You can also type the PC in the appropriate cell. The default description is the description of the first account where you assigned the code.
	5. Click OK. The new PC appears in the PC drop-down list.


	M-3 Tax Combination Codes (MCCs)
	Creating an M-3 Combination Code
	1. Go to the Trial Balance Grid screen.
	2. Select the appropriate MRC code from the drop-down list.
	3. Click the drop-down list for MCC and select<Add New>. The New Item dialog box appears.
	4. Type the MCC code and description in the New Code and Description fields. You can also type the MCC in the appropriate cell i...
	5. Click OK. The new MCC appears in the MCC drop-down list.

	Assigning an M-3 Combination Code
	1. Go to the Trial Balance Grid.
	2. Highlight the line for which you want to assign an MCC. Select the appropriate TRC code for that line.
	3. Select the appropriate MRC for that line,
	4. Select the MCC drop-down box. Existing MCCs and their descriptions are listed in the drop-down box.
	5. Select an MCC.
	6. Select Assign Coding. The MCC displays in the MCC column. (If you know which MCC to assign, you can type the MCC in the appropriate cell on the Trial Balance Grid.)

	Changing an M-3 Combination Code Description
	1. Go to the Trial Balance Grid screen.
	2. On the Edit menu, click TCC | PC | MCC. The Edit | TCC | PC | MCC dialog box appears.
	3. Select MCC Descriptions radial button to display MCCs and their corresponding descriptions.
	4. Click the MCC description field.
	5. Type the description change.
	6. Press Done when all necessary descriptions have been changed.

	Deleting an M-3 Combination Code
	1. Go to the Trial Balance Grid screen.
	2. On the Edit menu, click TCC/PC/MCC/Descriptions. The Edit TCC/PC/MCC Descriptions dialog box appears.
	3. Select MCC Descriptions radial button to display MCCs and their corresponding descriptions.
	4. Highlight the row containing the MCC you want to delete.
	5. Press Delete.
	6. This function deletes the MCC and MCC description and removes this information from the account on the Trial Balance Grid associated with that MRC and MCC.


	Workpaper Reference Codes
	Adding an Account to a Workpaper Reference Code
	1. On the Ledger menu, click Workpaper Notes.
	2. Select Add Account to assign an account to the selected Workpaper Reference Code. A dialog box appears, listing all the accounts on the Trial Balance grid.
	3. Select the account to which you would like to assign a Workpaper Reference Code, and select Use Account.
	4. Upon changing your view to another Workpaper Reference Code or closing the dialog box, your changes are saved automatically. The Trial Balance grid is updated automatically with the new Workpaper Reference Code’s information.
	5. Select Done when you have finished adding and modifying notes.

	Removing an Account from a Workpaper Reference Code
	1. Select the account in the Associated Accounts list box.
	2. Select Remove Account to unassign an account.
	3. Your changes are saved automatically. The Trial Balance grid is updated automatically with the new Workpaper Reference Code’s information. You may also delete the Workpaper Reference Code for a particular account on the Trial Balance grid itself.
	4. Select Done when you have finished adding and modifying notes.

	Viewing the Workpaper Reference Codes
	1. Select Prior and Next to scroll through the Workpaper Reference Codes and display the associated accounts and note with each code.
	2. If changes are made to the existing Workpaper Reference Code’s note, you are prompted to save changes before displaying the information associated with the prior or next Workpaper Reference Code.

	Adding a Workpaper Reference Code
	1. Select New to add a new Workpaper Reference Code. The New Workpaper Code dialog box appears.
	2. Enter a new code and click OK to add it to the list box. The new code is highlighted so you can add accounts and a note associated with the new code.

	Deleting a Workpaper Reference Code
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	Viewing Data in Tax Format
	Accessing Journal Entry Detail
	1. On the Account Detail dialog box, access the Journal Entry Detail by double- clicking a journal entry in the list box.
	2. Changes you make to the journal entry cause a calculation and update the Tax Summary detail when you close the Journal Entry Detail dialog box.
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	Reports: Print and Print Preview
	Taxable Income Detail and Balance Sheet Detail Reports
	Taxable Income Summary
	Taxable Income Variance Detail and Schedule M-1 Variance Detail Reports
	Note:

	Taxable Income Variance Summary and Schedule M-1 Variance Summary Reports
	Note:

	Balance Sheet Summary
	Schedule M-1 Detail
	Schedule M-1 Summary
	Schedule M-2 Summary
	Adjusting Journal Entries
	Accounts and Details Affecting Journal Entry

	Workpaper Notes
	Notes:

	G/L Account Sequence
	TRC and TCC Summary
	Schedule M-3 Detail
	Schedule M-3 Summary
	Rental Real Estate, Other Rental, Royalty, and Farm Property Detail
	Rental Real Estate, Other Rental, Royalty, and Farm Property Summary
	Rental Real Estate, Other Rental, Royalty, Farm Summary
	Previewing Before Printing
	1. On the File menu, select Print Preview. A list of available reports appears.
	2. Select the report that you want to preview. The Preview what list box lists all reports available to view for the particular tax return type.
	3. Select the orientation you need, either Portrait or Landscape. The default is landscape. Note: Adjusting Journal Entries prev...
	4. Select Suppress Lines with Zero Balance if you only want to preview accounts with balances.
	5. To include the prior year balance on the taxable income reports, select the Include PYB on Taxable Income Reports check box.
	6. You can include format options such as background shading or small font by selecting the Include Shading in Background or Use Small Font check boxes.
	7. Click the Preview button to preview or the Cancel button to close the dialog box and return to the Trial Balance Grid screen.

	Printing a Trial Balance Report
	1. On the File menu, select Print. A list of available reports appears.
	2. Select the workpapers you want to print.
	3. Select the print orientation you need, either Portrait or Landscape. The default paper size for printing is 8 º inches by 11 ...
	4. You also have the option to print multiple reports at a time. Simply click and drag to highlight multiple reports, or click the Ctrl button as you select each report to print. Then click Print.
	5. Select Suppress Lines with Zero Balance if you only want to print accounts with balances.
	6. To include the prior year balance on the taxable income reports, select the Include PYB on Taxable Income Reports check box.
	7. You can include format options such as background shading or small font by selecting the Include Shading in Background or Use Small Font check boxes.
	8. Select the number of copies of the reports you want to print. To print multiple copies of the report, click each report to print and select the number of copies you want.
	9. Select Print to File to have the reports print to a file instead of directly to a printer.
	10. Click the Print button. To close the dialog box and cancel printing, select Cancel.
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	TRC Categories

	Note:
	Forms with updated TRCs will be available after the IRS finalizes all forms shown in this guide.
	1065 Tax Return Codes
	Form 1065
	2006 TRC
	DESCRIPTION
	CROSS- TIE
	FLOWS TO PAGE, LINE
	2007 TRC

	Schedule F
	2006 TRC
	DESCRIPTION
	CROSS -TIE
	FLOWS TO PAGE, LINE
	2007 TRC

	8825
	2006 MRC
	DESCRIPTION
	DIVISIONAL DETAIL ROLLUP
	FLOWS TO PAGE, LINE
	2007 TRC

	Schedule M-3
	2006 MRC
	DESCRIPTION
	CROSS -TIE

	8916-A Return Codes
	2006 MRC
	DESCRIPTION
	FLOWS TO PAGE, LINE


	1120 Tax Return Codes
	Form 1120
	2006 TRC
	DESCRIPTION
	CROSS- TIE
	FLOWS TO PAGE, LINE
	2007 TRC

	Schedule M-3
	2006 MRC
	DESCRIPTION
	CROSS -TIE

	Form 8916-A Return Codes
	2006 MRC
	DESCRIPTION
	FLOWS TO PAGE, LINE


	1120-C Tax Return Codes
	Form 1120-C
	2006 TRC
	DESCRIPTION
	CROSS- TIE
	FLOWS TO PAGE, LINE
	2007 TRC


	1120S Tax Return Codes
	Form 1120S
	2006 TRC
	DESCRIPTION
	CROSS- TIE
	FLOWS TO PAGE, LINE
	2007 TRC

	Schedule F
	2006 MRC
	DESCRIPTION
	CROSS -TIE

	8825
	2006 MRC
	DESCRIPTION
	DIVISIONAL DETAIL ROLLUP
	FLOWS TO PAGE, LINE
	2007 TRC

	Schedule M-3
	2006 MRC
	DESCRIPTION
	CROSS -TIE

	8916-A Return Codes
	2006 MRC
	DESCRIPTION
	FLOWS TO PAGE, LINE


	1120-REIT Tax Return Codes
	Form 1120-REIT
	2006 TRC
	DESCRIPTION
	FLOWS TO PAGE, LINE
	2007 TRC


	1120-RIC Tax Return Codes
	Form 1120-RIC
	2006 TRC
	DESCRIPTION
	FLOWS TO PAGE, LINE
	2007 TRC


	1120-F Tax Return Codes
	2006 TRC
	DESCRIPTION
	CROSS- TIE
	FLOWS TO PAGE, LINE
	2007 TRC


	Note: Forms with updated TRCs will be available after the IRS finalizes all forms shown in this guide.
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